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Cutting Using the Included Software
Thank you very much for purchasing the MDX-650/500.
•

To ensure correct and safe usage with a full understanding of this product's performance,
please be sure to read through this manual completely and store it in a safe location.

•

Unauthorized copying or transferral, in whole or in part, of this manual is prohibited.

•

The contents of this operation manual and the specifications of this product are subject to
change without notice.

•

The operation manual and the product have been prepared and tested as much as possible.
If you find any misprint or error, please inform us.

•

Roland DG Corp. assumes no responsibility for any direct or indirect loss or damage
which may occur through use of this product, regardless of any failure to perform on the
part of this product.

•

Roland DG Corp. assumes no responsibility for any direct or indirect loss or damage
which may occur with respect to any article made using this product.
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Introduction
This document describes operation when performing cutting with the MDX-650/500 using RML-1.
To perform cutting using RML-1, the command selection must be set to RML-1 when the MDX-650/500 is switched on. For information
on how to select commands, see "User's Manual 1 -- Setup and Maintenance."
If you’re using the MDX-650 with the optional rotary axis unit (ZCL-650), also see the “ZCL-650 User’s Manual” included with the
rotary axis unit.

Setting the Command Set to RML-1
This chooses the instruction set immediately after switching on the power. When an instruction set has been chosen, it cannot be changed
until the power is reset.

1

Switch on the power.
After the opening message, the screen for selecting the
instruction set appears.

2

Turn the dial to move the arrow to [RML-1], then press
the [ENTER] key.

Hit "ENTER" >RML-1
Select MODE NC-CODE

Choosing the Spindle Type
This sets the type of the installed spindle to MDX-650/500.
If a high-torque spindle is installed, choose [HIGH TORQUE]. If a high-speed spindle is installed, choose [HIGH SPEED]. An incorrect
selection may result in insufficient power to the motor and make normal cutting impossible, or conversely may apply power beyond the
rated capacity to the motor and cause an error to be displayed during cutting.

1

If the display shows coordinates, press the [ENTER] key
to display the main menu.

*X
Z

0
0

Y

0
5000 RPM

>1 SPEED SETTING
2 SPINDLE RPM
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2

Turn the dial to move the arrow to [OTHERS], then press
the [ENTER] key.

>10 OTHERS
11 To Coordinate

3

Turn the dial to move the arrow to [SPINDLE UNIT],
then press the [ENTER] key.

10>2 SPINDLE UNIT
3 BUZZER

4

Turn the dial to move the arrow to [HIGH TORQUE] or
[HIGH SPEED], then press the [ENTER] key.
The selected mode is enclosed in angle brackets.

10-2 SPINDLE UNIT
<HIGH TORQUE>
or
[HIGH SPEED]

* To go back to the main menu, press the [EXIT] key
several times.
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Part 1 Installing the Software
The Roland Software Package CD-ROM contains many different kinds of software.
You can view the software that can be used with MDX-650/500 by displaying the setup menu on the CD-ROM and choosing the model
of MDX-650 or MDX-500 .
See below for overviews and brief description of usage for the software displayed on the setup menu.

1-1 Software That Can Be Used with the MDX-650/500
Software

Overview

Windows driver

This is necessary when sending data to MDX-650/500 from a Windows-based program.
If you’re using Windows, be sure to install this driver.

MODELA programs

The Windows versions of MODELA Player, MODELA 3D DESIGN, and MODELA 3D
TEXT cannot be set up separately.

MODELA Player

This sets the required parameters for cutting solid objects and sends the cutting data to
MDX-650/500.
This can import not only solid objects created with three-dimensional programs from
Roland DG Corp., but also solid objects created using other commercially available threedimensional programs (via DXF or STL).

MODELA 3D DESIGN

This lets you choose a basic shape such as a cylinder or sphere, and modify it to create a
three-dimensional object.
You can intuitively create solid objects with smooth curves.
You can use MDX-650/500 to cut solid objects and save data in three-dimensional DXF
files.

MODELA 3D TEXT

This adds thickness to text to create three-dimensional characters.
It’s also possible to edit text to make it bold, italic, or the like. You can put a box around
text with just a single click — a handy feature when making nameplates.
You can use MDX-650/500 to cut three-dimensional text and save data in three-dimensional DXF files.

Virtual MODELA

This simulates tool movement before performing cutting with MDX-650/500.
You can use it to check the finished shape as well as things like whether the cutting depth
is suitable and how much time cutting will take. This can reduce loss for cutting materials
and time.

Dr.Engrave

This is used to design plates and send the engraving data to MDX-650/500.
You can make large numbers of plates with the same design with high efficiency. You can
use the TrueType fonts registered in Windows as the font style for text. You can even
make stroke fonts from TrueType fonts.
Because you can the outline of an image and convert it to line segments, it’s also possible
to include logos for companies or organizations in the plates you make.

3D Engrave

This adds thickness to a flat (two-dimensional) graphic to create a relief (raised engraving).
You can also add thickness to images such as illustrations.
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1-2 Installing the Software
This section describes installation and setup for the MDX-500. If you’re using the MDX-650, then wherever “MDX-500” appears in the
text, read “MDX-650” instead.

System Requirements
The system configuration for the programs that you can use with the MDX-650/500 (MODELA Applications, 3D Engrave, Virtual
MODELA, and Dr. Engrave) is as follows.
- Microsoft® Windows® 95, Windows 98, Windows Me, Windows NT® 4.0, or Windows 2000 operating system
- The minimum required CPU for the operating system (Pentium® or higher recommended)
- The minimum amount of required RAM for the operating system (32 Mbytes or more recommended)
- 32 Mbytes or more of free hard disk amount is required to install all programs.
*For information about the system requirements for individual programs, refer to the Readme file.

* If you are installing under Windows NT 4.0 or Windows 2000, you need full access permissions for the printer settings.
Log on to Windows as a member of the “Administrators” or “Power Users” group.
For more information about groups, refer to the documentation for Windows.

Setup

1

Switch on the computer and start Windows.

2

Place the CD from the Roland Software Package in the
CD-ROM drive.
The Setup menu appears automatically.

3

When the screen shown below appears, click the in
[Click here], then choose [MDX-500].
Click [Install].
To view the description of a program, click the
button.
To view the manual, click the
button.
(There are manuals in PDF format for the programs that
the
button references. Acrobat Reader is required to
view PDF files.)
If there are programs you don't want to install, then clear
their check boxes before you click [Install].
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4

The Setup program starts. Follow the messages to carry
out setup and finish setting up the program.

* When the setup for one program finishes, the setup
for the next program starts.
In the interval until the next setup starts, a dialog box
showing the progress of processing is displayed.

5

If the following screen appears while installing the driver,
click the drop-down arrow and choose the port for the
cable connected to the computer.
When using an RS-232C (serial) cable
[COM1:] or [COM2:]
When using a printer (parallel) cable
[LPT1:] or [LPT2:]

6

The driver settings appear.
When you make the settings for the communication
parameters of MDX-500, make the parameters match the
values displayed here.
Click [Close] to finish installing the driver. The driver
settings appear.

7

When all installation finishes, the screen at right appears.
Click [Close].

8

After returning to the menu screen for installation, click

9

Remove the CD-ROM from the CD-ROM drive.

.
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Application Settings
When you finish installing the applications, continue by making the following settings. Be sure to make the settings before use.

MODELA Player

1

Click [Start].
Point to [MODELA App Group] and click [mdx3p].

2

From the [Options] menu, click [Machines...].
The [Model Selection] dialog box appears.

3

Click [MDX-500 (RML-1)], then click [OK].

4

From the [File] menu, click [Print Setup...].
The [Print Setup] dialog box appears.

8

Part 1 Installing the Software

5

Click the drop-down arrow for the name and click
[Roland MODELA MDX-500 (RML-1)].
Then click [OK].

Dr.Engrave

1

Click [Start].
Point to [Roland Dr.Engrave] and click [Dr.Engrave].

2

From the [File] menu, click [Print Setup...].
The [Print Setup] dialog box appears.

3

Click the drop-down arrow for the name and click
[Roland MODELA MDX-500 (RML-1)].
Then click [OK].
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3D Engrave

1

Click [Start].
Point to [Roland 3D Engrave] and click [3D Engrave].

2

From the [Cut] menu, click [Machines...].
The [Model Selection] dialog box appears.

3

Click [MDX-500 (RML-1)], then click [OK].

4

From the [File] menu, click [Output Device Setup].
The [Print Setup] dialog box appears.

5

Click the drop-down arrow for the name and click
[Roland MODELA MDX-500 (RML-1)].
Then click [OK].
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1-3 How to Use Help
If you have trouble using the program or driver, see the help screens. Help contains information such as descriptions of software operation, explanations of commands, and tips for using the software more effectively.

1

From the [Help] menu, click [Contents].

2

Clicking on text that is green and underlined (by a solid
or dotted line) displays an explanation.

3

Clicking on an image area that contains an explanation
displays the explanation.

Tip:
- When the pointer moves over green underlined text, it changes to a pointing hand (

).

- When the pointer moves over a location where an explanation is included, it changes to a pointing hand (

).
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When there's a [?] button on screen
Clicking [?] in the upper-right corner of the window makes the
mouse pointer change to a question mark (
). You can then
move the pointer over any item you wish to learn more about,
then click on the item to display an explanation of it.

When there's a [Help] button on
screen
Clicking [Help] lets you view help for the window or software.
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1-4 Overview of the Usage Guide
The included Roland Software Package CD-ROM contains the following PDF file.

- Cutting Tips
This describes tips and tricks for double-sided cutting and methods for securing the workpiece in place.

Location of the Usage Guides
The usage guide is found at the following locations.
View the following file directly from the CD-ROM, or copy the following file to your hard disk and read them from there.

- Cutting Tips
[Document] - [Cuttips] - [Cuttip-e.pdf]

Installing the Acrobat Reader
Acrobat Reader is required to view PDF files.
If Acrobat Reader is not set up on your computer, you need to set it up.
The included CD-ROM also contains Acrobat Reader.
[Acrobat] - [English] - [ar405eng.exe]
(This runs under Windows 95, Windows 98, Windows Me, Windows NT 4.0, or Windows 2000.)
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Part 2 Basic Operation
2-1 Making Settings Using the Liquid-crystal Display
*X
Z

0
0

Y

0
5000 RPM

Pressing the [ENTER] key
at this time displays the menu.

You can move the tool or change the spindle speed by turning the
dial while coordinate values are displayed.
To move the tool, use the [JOG] key to choose an axis (either [X],
[Y], or [Z]), then turn the dial. To change the spindle speed, choose
[??00 RPM], then turn the dial.
At this time, a [*] (asterisk) appears next to the chosen item.

Main Menu

>1 SPEED SETTING
2 SPINDLE RPM

Turn the dial to move the
arrow ( ) to the item whose
setting you want to make.

>8 SERIAL PARAMETER
9 COMPENSATE

8>1 STOP BIT
2 DATA BIT
Turn the dial to move the
arrow ( ) to the item whose
setting you want to make.

Press the
[ENTER] key.

8>3 PARITY BIT
4 BAUD RATE

The value (or selection choice)
enclosed in angled brackets
(< >) indicates the current setting.

8-3 PARITY BIT
<NONE>

Press the [EXIT] key to
return to the previous screen.

Turn the dial to
change the setting.
Press the
[ENTER] key.

8-3 PARITY BIT
EVEN

Press the [EXIT] key to
return to the previous screen.

Press the
[ENTER] key.

8-3 PARITY BIT
<EVEN>
Angle brackets (< >) are displayed.
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2-2 Setting the Connection Parameters
Connection with a parallel cable is called a "parallel connection," and connection with a serial cable is called a "serial connection." Make
the appropriate settings on both the computer and the MDX-650/500 to configure the equipment for the type of connection that has been
made. Normally, the setting on the computer should be made to match the setting on the MDX-650/500. The steps below describe how
to set connection parameters on the MDX-650/500. To make the settings on the computer, refer to the manual for the computer or the
software in use.

1

Press the [EXIT] key to display the main menu.

2

Turn the dial to move the arrow to [CONNECTION],
then press the [ENTER] key.

>7 CONNECTION
8 SERIAL PARAMETER

3

Turn the dial to choose [AUTO], then press the [ENTER]
key.

7 CONNECTION

4

Press the [EXIT] key once to return to the screen at right.

>7 CONNECTION
8 SERIAL PARAMETER

5

Turn the dial to move the arrow to [SERIAL PARAMETER], then press the [ENTER] key.

>8 SERIAL PARAMETER
9 COMPENSATE

6

Turn the dial to move the arrow to the item you want,
then press the [ENTER] key.

8>1 STOP BIT
2 DATA BIT

7

Turn the dial to choose a value (or selection), then press
the [ENTER] key.

8-1 STOP BIT

<AUTO>

For serial
connection
only

<1>
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2-3 Cutting Condition Setting
Before you begin the actual cutting process, the cutting conditions such as the revolution speed of the spindle motor and the feeding
speed of each axis must be designated according to the quality of the workpiece and the type of tool used. There are several deciding
factors to be taken into account when designating the cutting conditions.

The quality of the workpiece
The cutting method

The type of tool used
The cutting shape

The diameter of the tool used

Designate the cutting conditions in consideration of the above factors by performing the following three MDX-650/500 setting operations.
1. The spindle motor revolution speed (tool revolution speed)
2. The feeding speed (tool moving speed)
3. The cutting-in amount (depth of one cutting operation)
Note : You can set the cutting conditions using either the program or the MDX-650/500.
If you change the cutting conditions while cutting is in progress, the settings made last take priority.
(As an example, assume you pause the MDX-650/500 while cutting is in progress, then change the feed rate and spindlerotating speed. After you make the changes using this method, if commands for the feed rate and spindle-rotating speed
are then sent from the computer, they conditions change to those specified by the commands.)
In this manual, these three conditions are called the cutting conditions. The characteristics and points to consider for each of these
conditions are as follows.

Item
Spindle motor revolution
speed

Characteristics/Points to Consider
The bigger this number, the faster the cutting speed. However, if this number is too large, the
work surface may melt or burn due to excessive friction. Conversely, if this number is made
smaller, the time taken for cutting becomes too longer. Generally speaking, the entire cutting
speed is determined by the cutting edge speed, so the smaller the tool diameter, the higher the
spindle revolution speed required. (When performing engraving without rotating the cutting
tool, set [SPINDLE CONTROL] to [OFF.])
Revolution speed
When [SPINDLE UNIT] is set to [HIGH SPEED]
When [SPINDLE UNIT] is set to [HIGH TORQUE]

16

: 5000 to 20000 rpm
: 3000 to 12000 rpm

Feeding speed

When the feeding speed is high, processing becomes rough and flash marks tend to remain on
the cut surface. On the other hand, when the feeding speed is slow, processing takes more
time. Be careful because a slower feeding speed does not always result in improved finishing.

Cutting-in amount

When the cutting-in amount is deeper, the cutting speed increases, but the cutting-in amount is
limited by the quality of the workpiece. In cases where the required depth can not be cut at
once, repeat cutting several times to depth that does not breach the limit.

Part 2 Basic Operations

Setting the Cutting Conditions
This section describes how to set the cutting conditions using the display on the MDX-650/500.
* If the cutting conditions can be set with your current software, this is a faster and more efficient method than manual
setting. It makes no difference when you come to construct a program.

Speed

1

Press the [EXIT] key to display the main menu.

2

Turn the dial to move the arrow to [SPEED SETTING],
then press the [ENTER] key.

>1 SPEED SETTING
2 SPINDLE RPM

3

Turn the dial to move the arrow to the item you want,
then press the [ENTER] key.

1>1 X/Y CUT SPEED
2 Z DOWN SPEED

* Set the feed speed during cutting with [XY CUT
SPEED] and [Z DOWN SPEED], and set the
movement speed when the tool is raised with [XY
MOVE SPEED] and [Z UP SPEED].

4

Turn the dial to change the value, then press the [ENTER]
key.

1-1 X/Y CUT SPEED
< 2 mm/s>
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Spindle Motor Revolution Speed
Making the Setting Using the Display Menu

1

Press the [EXIT] key to display the main menu.

2

Turn the dial to move the arrow to [SPINDLE RPM],
then press the [ENTER] key.

>2 SPINDLE RPM
3 MECHA MOVING
RPM : Revolutions Per Minute

3

Turn the dial to change the value, then press the [ENTER]
key.

2 SPINDLE RPM
< 5000 RPM>

* The set speed is stored in memory even after you
switch off the power, and remains in effect until you
make a new setting.

Making the Setting When Coordinate Values Are Displayed

1

Press the [EXIT] key to display the coordinate-view
screen.

*X
Z

2

Press the [JOG] key to move the [*] to [??00 RPM].

X
Z

3

Turn the dial to change the speed.

0
0

Y
0
5000 RPM

0 Y
0
0 * 5000 RPM

X
Z

0 Y
0
0 * 5000 RPM

* When you switch off the power, the set speed is lost
and reverts to the setting for [SPINDLE RPM].
RPM : Revolutions Per Minute

Cutting-in Amount
The cutting-in amount is set by setting Z1. For more information on the Z1 setting, see "2-5 Setting the Z1 and Z2 Position."
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Cutting Condition Setting Examples
The chart below contains reference examples of the appropriate cutting conditions for several types of workpiece material. In the case
that the conditions are input using software or when constructing your own programs, set the cutting conditions with reference to the
chart. However, because conditions differ depending on tool sharpness and workpiece hardness, cutting performance may not always be
optimal when adhering to the conditions specified below. In such a case, delicate adjustment should be performed at the time of actual
cutting.

Workpiece
Modeling wax (option)

Chemical wood

Acrylic resin

Tool

Spindle revolution

Cutting-in amount

XY axis feeding

Z axis feeding

speed [RPM]

[mm]

[mm/sec.]

[mm/sec.]

ZUS-600

8000

2

18

18

ZEC-H4032

10000

0.5

30

10

ZHS-H4400

10000

0.8

30

5

ZUS-600

8000

2

20

20

ZEC-H4032

10000

0.4

30

10

ZHS-H4400

10000

0.5

30

5

ZUS-600

8000

0.37

16

16

ZEC-H4032

10000

0.2

15

5

ZHS-H4400

10000

0.2

15

5

ABS plastic

ZUS-600

8000

0.37

24

24

Aluminum

ZUS-600

8000

0.2

14

3

ZEC-H4032

12000

0.05

5

1

ZHS-H4400

Without rotation

0.1

10

1

ZDC-D2000

Without rotation

0.1

10

1

ZUS-600

8000

0.2

14

3

ZEC-H4032

12000

0.05

5

1

ZHS-H4400

Without rotation

0.1

10

1

ZDC-D2000

Without rotation

0.1

10

1

ZUS-600

12000

3

40

30

ZUS-300

12000

2

40

30

Brass

Sanmodur SS (option)
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2-4 Setting the Origin Points (XY Origin Point and Z0)
Make the settings for the XY origin (the origin point for the X and Y axes) and Z0 (the Z-axis origin point).

About the XY Origin Point
You can choose from among three types according to the target and usage.
These are broadly divided into points are set where you want (USER) and points that are set as mechanical fixed points (LIMIT and
CENTER). For the latter, you can also choose either the front left or the center.
This section describes the selections. For information about how to make the selections, see "Choosing the XY Origin" in the following
section.

Table

USER
This sets the origin point where you want.
Choose this when setting the origin point to match the position
where the workpiece is loaded. The setting is normally made at the
front-left corner of the workpiece.

Maximum cutting range

Workpiece

Y
X
XY Origin Point ([USER])

Table

LIMIT
This is a mechanical fixed point on the MDX-650/500, and is set
at the front-left corner of the maximum cutting range.

Maximum cutting range

Y
X

XY Origin Point
([LIMIT])

CENTER
This is a mechanical fixed point on the MDX-650/500, and is set
at the center of the maximum cutting range.
However, you can offset the centerpoint in order to use a center
vise. For more information, see "Offsetting the Centerpoint."

Table
Maximum cutting range

Y
X
XY Origin Point
([CENTER])
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Setting the XY Origin Point
Choosing the XY Origin Point

1

Press the [EXIT] key to display the main menu.

2

Turn the dial to move the arrow to [ORIGIN CHANGE],
then press the [ENTER] key.

3

Turn the dial to move the arrow to the item you want,
then press the [ENTER] key.
If you chose [USER], then continue with the procedure in
"Setting the Origin Where You Want."
To choose [CENTER] and offset the centerpoint aligned
with the center of the center vise, see "Offsetting the
Center Location."

>4 ORIGIN CHANGE
5 MOVING MODE

4 ORIGIN

CHANGE
<USER>

Setting the Origin Where You Want
If you chose [USER] with [ORIGIN CHANGE], then set the origin point where you want on the loaded workpiece.
The following section describes how to set the origin point. This section assumes that the XY origin point is set at the front-left corner of
the workpiece.

1

Press the [EXIT] key to display the coordinate-view
screen.

2

Press the arrow keys and the TOOL UP/DOWN keys to
move the cutting tool to a position close to the front left
corner of the workpiece.

3

Press the [JOG] key to move the [*] on the screen to [X]
or [Y].

*X
Z

0
0

Y
0
5000 RPM
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4

Turn the dial to move the tool a little at a time.

5

Repeat steps 3 and 4 to align the center of the tool with
the front-left corner of the workpiece.

6

Press the [XY/A] key (If you're using MDX-500, press
[XY] key) to display the screen at right.

7

Press the [ENTER] key.
The screen flashes once, then returns to the coordinate
view.

22

Set User Origin
Hit "ENTER" key
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Offsetting the Center Location
When the [ORIGIN CHANGE] selection is [CENTER], the origin point is set at the center of the workpiece mounted in the center vise.

1

Turn the dial to move the arrow to [MECHA MOVING],
then press the [ENTER] key.

>3 MECHA MOVING
4 ORIGIN CHANGE

2

Turn the dial to move the arrow to [Go CENTER Pos.],
then press the [ENTER] key.
Move the tool to the center of the cutting area.

3 >8 Go CENTER Pos.
9 Go LIMIT Pos.

3

While no material is attached, tighten the center vise
completely.

4

Press the [EXIT] key to display the coordinate-view
screen.

5

Use the arrow keys and the TOOL UP/DOWN keys to
move the tool to a position near the upper surface of the
center vise.

*X
Z

0
0

Y
0
5000 RPM

* Here, if the tip of the tool is exactly at the center of
the center vise, you don't need to make the following
settings. The center of the cutting area matches the
center position of the center vise.

6

Use the dial to align the tip of the tool with the center of
the center vise.

7

Press the [XY/A] key (If you're using MDX-500, press
[XY] key) to display the screen at right.

Set Center Position
Hit "ENTER" key

8

Press the [ENTER] key.
The screen flashes once, then returns to the coordinate
view.

*X
Z

0
0

Y
0
5000 RPM

* The finely adjusted center position is stores in memory even
after you switch off the power.
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Setting the Z0 Position
The Z0 position is the point that becomes the origin point in the Z directions. Usually, this point is set at the surface of the fixed
workpiece. (The following explains the method for setting the workpiece surface Z0 position.)

1

Press the [EXIT] key to display the coordinate-view
screen.

2

Press the arrow keys and the tool up/down keys to move
the cutting tool close to the surface of the workpiece.

3

Turn the dial to align the tip of the cutting tool with
surface of the workpiece.

4

Press the [Z] key.

5

Turn the dial to move the arrow to [Set Z0 Pos. HERE],
then press the [ENTER] key.
The screen flashes once, then returns to the coordinate
view.

*X
Z

0
0

Y
0
5000 RPM

>1 Set Z0 Pos. HERE
2 Set Z1 Pos. HERE

* The set value is stored in memory even after you switch off
the power.

The following method can be used to set the Z0 position even more precisely. This method is suitable for cases
where the position is marked with an oil pen and later cut off.
Set Z0 as the position where the ink was cut off.

First, make a mark on the work
surface with a generally
available oil pen, etc.

Workpieace

24

Press the [SPINDLE] key to make the
spindle rotate. Place the tool in the
marked position, then lower the tool until
the ink is cut off. The ink mark on the
work surface has a certain thickness, so
only the ink is removed.
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Setting Z0 with the Z0 Position Sensor (Included with the
Unit)
The Z0 sensor included with the unit is used to set the Z0 point on
the surface of the workpiece. The Z0 sensor is placed on the
location which is to serve as the Z0 point, and the Z0 point is set.

1

Z0 Position Sensor

Z0

Install the Z0 position sensor.

NOTICE

Do not connect the Z0 sensor to the EXT2
connector. Doing so may damage the
sensor.

2

Place the Z0 position sensor on top of the workpiece.

3

Use the arrow keys and the tool up/down keys to move to
a position 2 to 3 mm (0.079 in. to 0.118 in.) above surface
of the Z0 sensor.

4

Press the [EXIT] key to display the main menu.

5

Turn the dial to move the arrow to [OTHERS], then press
the [ENTER] key.

Z0 position sensor jack
Z0 position sensor

>10 OTHERS
11 SELF MODE
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6

Turn the dial to move the arrow to [SENSOR MODE],
then press the [ENTER] key.

10>1 SENSOR MODE
2 SPINDLE UNIT

If the Z0 sensor is not installed, the display shows the
screen at right for several seconds, then returns to the
previous screen.

10-1 SENSOR MODE
Z0 SENSOR NOTHING

Install the Z0 sensor, make sure the arrow is at [SENSOR
MODE], then press the [ENTER] key.

10>1 SENSOR MODE
2 SPINDLE UNIT

10-1 SENSOR MODE
Please Cursor Move

7

Use the tool up/down keys and the dial to move the
cutting tool until its tip comes into contact with the Z0
position sensor.

Press the TOOL DOWN key or turn the dial to display the
screen at right.

*X
Z

0
0

Y
0
[SENSOR]

When the tool comes into contact with the Z0 sensor,
movement stops and the screen at right appears.
The tool rises and the display returns to the previous
screen.

8

10>1 SENSOR MODE
SET Z ORIGIN!

Remove the Z0 position sensor.

* The set value is stored in memory even after you switch off
the power.

The Z0 sensor removed from above the workpiece must be placed outside the cutting range. Otherwise the cable may
become caught during operation of the XY table, damaging the sensor.
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2-5 Setting the Z1 and Z2 Position
The cutting tool up position (Z2 point) and down position (Z1
point) are normally set with the software. If they cannot be set
with your current software then set them manually using the keys
on the switch panel.

Tool up position
Z2
Z axis
Z0
origin point

Tool
Workpiece

Z1
Tool down position

1

Press the [EXIT] key to display the coordinate-view
screen.

2

Press the arrow keys and the tool up/down keys to move
the cutting tool close to the point where Z1 will be set.
When setting Z1, move the cutting tool to a position away
from the loaded workpiece.

3

Turn the dial to gradually move the cutting tool to the
height where the Z1 point is to be set.

4

Press the [Z] key.

5

Turn the dial to move the arrow to [Set Z1 Pos.HERE] for
Z1 or to [Set Z2 Pos.HERE] for Z2. Then press the
[ENTER] key.
The screen flashes once, then returns to the coordinate
view.

*X
Z

0
0

Y
0
5000 RPM

Z1

>2 Set Z1 Pos. HERE
3 Set Z2 Pos. HERE
Z2

* The set value is stored in memory even after you switch off
the power.

>3 Set Z2 Pos. HERE
-<END>-
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2-6 Downloading Cutting Data

Do not insert the fingers between
the XY table and base or between
the head and Z cover.

Do not insert the fingers between
the T-slot table and arms or between
the head and Z cover.

Doing so may result in injury.

The fingers may be pinched, resulting in
injury.
Head

Z cover
T-slot table

Arm

Do not wear gloves, a necktie or
wide-sleeved clothing.

Do not operate beyond capacity or
subject the tool to undue force.

They may become
caught in the tool,
resulting in injury.

The tool may break or fly off in a random
direction. If cutting beyond capacity is
mistakenly started, immediately turn off the
switch.

Wear dust goggles and mask during
use.

Use a commercially available brush
to remove metal cuttings.

Cutting dust may scatter, causing bodily
injury.

Attempting to use a
vacuum cleaner to
take up metal
cuttings may cause
fire in the vacuum
cleaner.

Perform dry cutting with no cutting
oil.
Such materials can
cause fire.

To keep cutting waste from being scattered, we recommend using a commercially available vacuum cleaner to take up
cutting waste during cutting. For information on attaching a vacuum cleaner, see "User's Manual 1 - Setup & Maintenance."
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When performing cutting using three-dimensional data created with a commercial program (in DXF or STL format), output is from the
included MODELA player program. This document describes some examples of cutting using MODELA Player. Refer to "Part 3
Software Guide - 3-2 Cutting Using MODELA Player."
When performing output from the included Dr. Engrave program or a commercially available drawing program, use the included 2.5D
Driver (Windows only). For more information about the 2.5D Driver, see the help screens for the 2.5D Driver on the included CD-ROM
and "Part 3 Software Guide - 3-1 Windows Driver."
For information on how to use the included programs, take a look at "Part 3 Software Guide" and the help screens for each of the
programs.
When cutting starts, the screen at right appears.

LOAD Min[>>>>>>>]MAX
20000RPM

- You can change the spindle speed by turning the dial. Note that the changed spindle speed is in effect only during cutting.
- Pressing the [EXIT] key displays the coordinate view screen only while the key is held down. (Displaying the coordinates while
cutting is in progress may lengthen the cutting time.)

Stopping the Cutting Process
If you want to change the shape to cut and redo cutting from the beginning, or if the data was different from what you wanted to cut, then
follow the steps below to stop operation.

1

While operation is in progress, press the [PAUSE] key.
Movement of the tool and table stops. Note that because
this is not an emergency stop, movement may continue
for two or three seconds before stopping.
The screen at right appears.

2

Stop sending data from the computer

3

Stop execution of the program.

PAUSE>CONTINUE
STOP

PAUSE>STOP
X/Y CUT SPEED
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Changing the Feed Rate or Spindle Speed During Cutting
The feed rate and spindle rotating speed set by the software can be changed while cutting is in progress.
This is done by first pausing the MDX-650/500 during cutting, then changing the feed rate or spindle rotating speed. However, if the
computer subsequently sends a command to change the feed rate or spindle rotating speed, the setting will change as specified by the new
command. When set by software or set directly on the MDX-650/500, the setting made last takes precedence.
The following method is appropriate for making delicate halfway adjustments to conditions previously set using software, etc.
For more information about the spindle-motor speed and the feed rate, refer to "2-3 Setting the Cutting Conditions."

1

While operation is in progress, press the [PAUSE] key.
Movement of the tool and table stops. Note that because
this is not an emergency stop, movement may continue
for two or three seconds before stopping.
The screen at right appears.

PAUSE>CONTINUE
STOP

2

Turn the dial to move the arrow to the item you want,
then press the [ENTER] key.

PAUSE>X/Y CUT SPEED
Z DOWN SPEED

3

Turn the dial to change the value, then press the [ENTER]
key.
To change another item, press the [EXIT] key, then repeat
steps 2 and 3.

PAUSE:X/Y CUT SPEED
< 2 mm/s>

4

Press the [EXIT] key to return to the screen at right.

PAUSE>CONTINUE
STOP

5

Turn the dial to move the arrow to [CONTINUE], then
press the [ENTER] key.
The paused state is canceled and cutting resumes.
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2-7 Finishing

Do not touch the tip of the blade
with your fingers.
Doing so may result in injury.

Please use a vacuum cleaner to
remove cutting dust.
Do not use any blower like airbrush.
Otherwise, dust spread in the air may harm
your health.

Do not touch the tool immediately
after cutting operating stops.

Use a commercially available brush
to remove metal cuttings.

The tool may have become hot due to
friction heat and may cause burns if
touched.

Attempting to use a
vacuum cleaner to
take up metal
cuttings may cause
fire in the vacuum
cleaner.

After cutting has been finished, detach the tool, remove the material, and clean away chips.

1

Press the [EXIT] key to display the main menu.

2

Turn the dial to move the arrow to [MECHA MOVING],
then press the [ENTER] key.

>3 MECHA MOVING
4 ORIGIN CHANGE

3

Turn the dial to move the arrow to [Go LIMIT Pos.], then
press the [ENTER] key.

3 >9 Go LIMIT Pos.
10 To Main MENU

4

Detach the tool.
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5

Turn the dial to move the arrow to [Go VIEW Pos.], then
press the [ENTER] key.

6

Remove the material.

7

Use a commercially available vacuum cleaner to take up
cutting waste.
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3 >3 Go VIEW Pos.
4 Go Z1 Pos.

Part 3 Software Guide

Part 3 Software Guide
This describes the general procedures for software you can use with MDX-650/500.
For detailed descriptions, take a look at the help screens for the respective software.
This section describes operation on the MDX-500. If you’re using the MDX-650, then wherever “MDX-500” appears in the text, read
“MDX-650” instead.

3-1 Driver for Windows
Driver for Windows 95/98/Me
This sends data to MDX-650/500 from a Windows-based program.
When sending data from Dr. Engrave or a commercially available drawing program, the driver sets engraving parameters such as the
tool’s operating speed, depth, and pitch.
When sending data from MODELA Player or 3D Engrave to MDX-650/500, the data is sent to the driver’s output port. At this time, all
driver settings other than the port are ignored, and do not affect cutting.
This section explains how to make the settings for the engraving parameters.

Display the Driver Setting Screen
To make the settings for the driver, open Properties. You can use either of the two methods described below to open Properties.

Method 1
To save values you've changed with Properties, use this method to make the settings.

1

Click [Start]. Point to [Settings] and click [Printer].
The [Printers] folder appears.

2

Right-click on the [Roland MODELA MDX-500 (RML1)] icon, then click [Properties].
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Method 2
If you opened Properties for the driver from a program, the values you set there are only temporary, and are not saved. To save the
Properties settings for the driver, use Method 1.

1

Start the program and open a file.

2

From the [File] menu, click [Print Setup...].
The [Print Setup] dialog box appears.

3

Set the printer to [Roland MODELA MDX-500 (RML1)], then click [Properties].

Enter the Cutting Area
Enter the size of the workpiece installed on MDX-500.

1

Click the [Size] tab.

2

Enter values for [Width] and [Length].
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Set the Engraving Parameters
You can assign different colors to the data and set the parameters for performing engraving of the corresponding data by color.

1

Click the [Tool] tab.

2

Click the tab for the color to set.
The numeral appearing next to the color is the tool
number that is now set.

3

Click the drop-down arrow for [Tool], then click the tool
number.
If you don’t wish to engrave lines of that color, click
[None].

4

For [Z Down Position], enter the cutting-in depth.
Cutting to the depth of [Z Down Position], with each
cutting pass made at the depth set with [Z Engraving
Pitch].
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If the tool-down position (Z1) is set at a location lower
Bad Parameter
than the Z-axis cutting range, the screen at right appears
while cutting is in progress, and operation pauses.
When cutting material of uneven thickness using the depth regulator nose, set the tool-down position at a lower
height than the actual cutting depth (see "User's Manual 1 - Setup & Maintenance"). As a result, the tool-down
position (Z1) is set at a location lower than the Z-axis cutting range.
To clear the error message, switch off the power.
To avoid errors, place a flat board under the workpiece to serve as a lifting base.

5

For [Fill Pitch], enter the diameter of the tool tip.
To achieve an attractive finish, enter a value narrower
than the actual diameter.

Driver for Windows NT 4.0/2000
This sends data to MDX-650/500 from a Windows-based program.
When sending data from Dr. Engrave or a commercially available drawing program, the driver sets engraving parameters such as the
tool’s operating speed, depth, and pitch.
When sending data from MODELA Player or 3D Engrave to MDX-650/500, the data is sent to the driver’s output port. At this time, all
driver settings other than the port are ignored, and do not affect cutting.
This section explains how to make the settings for the engraving parameters.
To make the settings for a printer driver, you need full access permissions for printer setup.
Log on to Windows as a member of the “Administrators” or “Power Users” group.
For more information about groups, refer to the documentation for Windows.

The description of the following procedures use screen shots from Windows 2000.

Display the Driver Setting Screen
To make the settings for the driver, open Properties. You can use either of the two methods described below to open Properties.
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Method 1
To save values you've changed with Properties, use this method to make the settings.

1

Click [Start]. Point to [Settings] and click [Printer].
The [Printers] folder appears.

2

If you're using Windows 2000, right-click the [Roland
MODELA MDX-500 (RML-1)] icon, then click [Printing
Preferences].
The [Printing Preferences] dialog box appears. Click
[Advanced].
If you're using Windows NT 4.0, right-click the [Roland
MODELA MDX-500 (RML-1)] icon, then click [Document Defaults].

Method 2
If you opened Properties for the driver from a program, the values you set there are only temporary, and are not saved. To save the
Properties settings for the driver, use Method 1.

1

Start the program and open a file.

2

From the [File] menu, click [Print Setup...].
The [Print Setup] dialog box appears.

3

Set the printer to [Roland MODELA MDX-500 (RML1)], then click [Properties].
If you're using Windows 2000, the [Property] dialog box
displays. Click [Advanced].
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Enter the Cutting Area
Enter the size of the workpiece installed on MDX-650/500.

1

Click the [Work Size Settings] document option.
For Windows 2000, click [Properties]. For Windows NT
4.0, click [Work Size Settings].
The [Work Size Setting] dialog box appears.

2

Click [Add New Work Size], then for [Work Size], enter
values for [Width] and [Length].

3

Enter the [Work Size Name], then click [OK].
* For [Work Size Name], use only alphanumeric characters.
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Set the Engraving Parameters
Make the settings for the composition of the workpiece to engrave and the engraving depth.
Choosing the composition sets engraving parameters suited to this engraving. However, [Tool Down Position] and [Fill] - [Tool Width]
are determined with no relation to composition, and so they are set separately. For [Tool Down Position], enter the engraving depth. For
[Fill] - [Tool Width], enter the tool diameter.
The values for settings other than [Tool Down Position] and [Fill] - [Tool Width] are also suggested guidelines. If the results of actual
engraving are not as expected, modify the values accordingly.
Lines are distinguished by color, and parameters when engraving a line of the corresponding color are set.

1

Click any tool from 1 to 4 to display the lower level.
Click [Material], then click the composition of the
engraving material (workpiece).

2

Double-click [Color] to display the lower level.
Click the color to set, then click the tool number.
If you don’t wish to engrave lines of that color, click
[None].
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3

Double-click on the tool number to display the lower
level.
Click [Z Down Position] and enter the cutting-in depth.
Cutting to the depth of [Z Down Position], with each
cutting pass made at the depth set with [Z Engraving
Pitch].

If the tool-down position (Z1) is set at a location lower
Bad Parameter
than the Z-axis cutting range, the screen at right appears
while cutting is in progress, and operation pauses.
When cutting material of uneven thickness using the depth regulator nose, set the tool-down position at a lower
height than the actual cutting depth (see "User's Manual 1 - Setup & Maintenance"). As a result, the tool-down
position (Z1) is set at a location lower than the Z-axis cutting range .
To clear the error message, switch off the power.
To avoid errors, place a flat board under the workpiece to serve as a lifting base.

4

For [Fill], click [Tool Width], then enter the diameter of
the tool tip.

For items other than [Tool Down Position] and [Fill] - [Tool Width], suitable values are set for engraving the composition you chose in step 1. However, these values are only suggestions. If the results of actual engraving are not as
expected, adjust the values accordingly.
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3-2 Application Software
MODELA 3D DESIGN
This lets you choose a basic shape such as a cylinder or sphere, and modify it to create a three-dimensional object.
You can intuitively create solid objects with smooth curves.

Choose the basic shape

1

Click

.

The [Primitives] dialog box appears.

2

Click the basic shape that is closest to the finished form.
Enter the size, then click [OK].

Decide on the number of reference lines
The reference lines are control rods for arranging the shape of the object.
To determine the number of reference lines, click the controls shown below.

: 4 lines

: 7 lines

: 10 lines
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Manipulate Reference Lines to Make a Shape
To change the height of a reference line, position the pointer over
the reference line and drag it up or down.

To change the size of the outer perimeter for a reference line,
position the pointer over the reference line and drag it to the left or
right.

To change the shape of the outer perimeter, right-click on a
reference line.
The [Select section] dialog box appears.
Make the settings to obtain the desired shape.

To change the centerpoint of the outer perimeter, click
drag the reference line.

42
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Check the shape

1

Click the

.

The [Rendering] dialog box appears.

2

Drag the scroll box for the X, Y, or Z scroll bar.
The object rotates, letting you view it from various
perspectives. To color the object, click [Start].

Save the data
Click the

.

The [Save As] dialog box appears.
Enter the name of the file and click [Save].
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Description of Controls
This opens new file.

This saves the data as a DXF file.

This opens an existing file.

This starts MODELA Player.

This saves the file, overwriting the previous data.

This undoes the very last operation.

This moves a reference lines up or down.
When
is selected, the location of the
centerpoint moves up or down.
This moves a reference lines right and left.

This zooms the screen in or out.

This displays the coordinates of the reference
lines.

is selected, the location of the
When
centerpoint moves right and left.

This changes the point of view.

When this is selected, dragging a reference line
changes the size of the outer perimeter.

This adds color and shadowing to the object's
surfaces.

When this is selected, dragging a reference line
moves the centerpoint of the outer perimeter.

This determines the number of
reference lines.
This displays help for 3D DESIGN.
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MODELA 3D TEXT
This adds thickness to text to create three-dimensional characters.
You can use the TrueType fonts registered in Windows as the font style for text.

Enter the Text
Click the [Edit] text box, then type in the text.
Make sure what you’ve typed in is correct, then click [Go!].

Determine the Font and Size of the Text

1

Click the [Font] drop-down arrow, then click on a font
name.

2

Click the [Scale] drop-down arrow, then click on a size.

- You cannot specify a font size that is not listed.
- If you want to know the size of the entire text string that you typed in, click [Show Information].

Save the data
Click the
.
The [Save As] dialog box appears.
Enter the name of the file and click [Save].
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Description of Controls
This opens new file.

This lets you choose the color of the object from
among ten available colors.

This opens an existing file.

This assigns the desired color to the object.

This saves the file, overwriting the previous data.

This displays dimensions around the object.

This changes how the object is displayed.

This saves the data as a DXF file.

This slants each individual character to the
left or right.

This starts MODELA Player.

This slants the text in the height direction.

This puts a frame around the text.

This changes the height of the text.

This rotates each individual character 90 degrees
counterclockwise.

This determines the roughness of curved
portions of the text.

This makes the text italic.

This inverts the background color.

This makes the text bold.

MODELA Player
For information on how to use MODELA Player, see “3-3 Cutting Using MODELA Player.”
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Virtual MODELA
You can use a tool path created with MODELA Player or 3D Engrave to verify the cutting process and results on-screen before you
perform actual cutting.
You can start this program directly with commands from MODELA Player or 3D Engrave. For more information, see "3-2 Application
Software 3D Engrave."
With Virtual MODELA, you can display the cutting process and results in a wide variety of ways.

Animating the Screen During Simulation
Click the

, this button is on. When it is off, only the shape after simulation is displayed.

Switching the Screen Between Flat and Three-dimensional Views During
Simulation
•

Clicking
switches from a flat view to a three-dimensional view.
When this button is selected, the view is three-dimensional during and after simulation.

•

Clicking
switches from a three-dimensional view to a flat view.
When this button is selected, the display shows a view of the workpiece as seen from above during and after simulation.

Changing the Perspective at the Simulation Screen (Only During 3D View)
You can use the following buttons only when

has been clicked to display a 3D view.

•

Clicking

rotates the object counter-clockwise around the Z axis, in steps of 90 degrees.

•

Clicking

rotates the object clockwise around the Z axis, in steps of 90 degrees.

Checking the Shape After Simulation
You can use the following buttons only when

has been clicked.

Rotating
You can use the following buttons only when
clicked.

Zooming in or out
has been

Click

, then drag on the screen.

Zoom in
Drag toward the top of the screen.

Moving the Location
Click

, then drag on the screen.

Zoom out
Drag toward the bottom of the screen.
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Description of Controls
This creates a new, uncut workpiece.

This switches between adding and not adding
color to the surface of the workpiece.
To specify a color, click [Options] - [Surface
Color].

This opens an existing cutting-configuration file.

This saves the shape of the present workpiece in a
file.

This performs the cutting simulation over again,
using the presently imported tool path. Use this
when you want to check the movement of the tool
again.
This quits the simulation.

This starts cutting.
If cutting was previously interrupted, it resumes
cutting.

This displays a prediction of how much time
cutting will take. The time is a general estimate.
In addition to the time, you can also verify the tool
movement distance and movement range.
This displays the simulation screen as a flat (twodimensional) view.

This displays the simulation screen as a solid
(three-dimensional) view.

These change the perspective when
displaying a simulation three-dimensionally.

This is for checking the shape after cutting
simulation.

This displays the movement of the tool with
animation.
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This restricts the 3D view range.
It also determines the printing area when performing 2D simulation.
Restricting the range makes 3D view faster than
when displaying the entire workpiece.
This pastes and image on the surface of the
workpiece.
By pasting an image of wood or metal, you can
make the workpiece look more realistic.
T o select the image to paste, click [Options] [Texture Setup].

This rotates the object, changing the perspective.
This is available only during 3D view.

This zooms the view of an object in or out.
This is available only during 3D view.

This changes an object's displayed location on the
screen.
This is available only during 3D view.

This enlarges or reduces what is displayed to fill
the drawing size.

This selects how the object is
displayed when on the 3D screen
when not performing any operation.
This selects the image to paste on the surface of
the workpiece.

This changes the direction and brightness of
incident light, thereby changing the shading.
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Dr. Engrave
This is used to design plates and send the engraving data to MDX-650/500.
You can make large numbers of plates with the same design (such as nameplates and rating plates) with high efficiency.

Set the Engraving Area
The following explanation is for Windows 95/98/Me. If you're using Windows NT or Windows 2000, then refer to the explanation in "31 Driver for Windows Driver for Windows NT 4.0/2000 Enter the Cutting Area."

1

From the [File] menu, click [Print Setup...].
The [Print Setup] dialog box appears.

2

Make sure [Roland MODELA MDX-500 (RML-1)] is
specified as the printer, then click [Properties].
The [Roland MODELA MDX-500 (RML-1)] dialog box
appears.

3

Enter the size of the plate, then click [OK].
Next, click [OK] to close the [Printer Setup] dialog box.

4

The white portion of the screen is the engraving area. Lay
out shapes and text inside the area.
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Type in the Text
Click

, then click at the location where you want to type in

text.
While in this state, type in the text with the keyboard.

Draw a Shape
Click on the shape-drawing controls to draw the shapes.

Change the Size and Location of a Shape or Text
Click

, then click the shape or text.

Solid square (

) and triangle (

) pointers appear around the shape or text. To change the size, drag the pointers.

<Changing the Size>
Drag to change the vertical size.
You can freely change the size of the
object by dragging. To retain the
object’s vertical/horizontal aspect
when you change its size, hold down
the [Shift] key while dragging.
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Drag to change the horizontal size.
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<Rotating and Slanting>
Clicking again makes the pointers change to circles (
Drag to rotate the shape.

) and diamonds (

).
Drag the “

” to slant the shape.

<Moving the Location>

To change the location, drag between
the pointers.

Save the Data
Click the

.

The [Save As] dialog box appears.
Enter the name of the file and click [Save].

Start Engraving
Click the

.

The [Save As] dialog box appears.
To start engraving with MDX-500, click [OK].
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Description of Controls
This opens new file.

This zooms the screen in or out.

This opens an existing file.

This types in the text

This saves the file, overwriting the previous data.

This draws the shapes

This sends engraving data to MDX-650/500.

This deletes the selected object and copies it to the
clipboard.
This copies the selected object to the clipboard.

This changes the chosen text string to line
characters.

This copies the clipboard data to the screen.

This performs flat-drag machining for the interior
of a shape or text.

This selects a shape or text.

This is used to reposition the vertices of a polygon,
changing its shape.
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This makes an entry frame for text.

These change the context of an object.

These set the direction of the text string.
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3D Engrave
This adds thickness to a flat (two-dimensional) graphic to create a relief (raised engraving).
You can also add thickness to images such as illustrations.
3D Engrave is a program for creating reliefs (raised engravings) and engravings on curved surfaces.
This section describes the steps for cutting a relief.
For detailed descriptions of the creation steps and more information about creating data for engraving,

Select the Output Device
Choose the MDX-650 or the MDX-500 as the output device. For more information, take a look at "Part 1 Installing the Software 1-2
Setting Up the Windows Version of the Program Application Settings."

Decide on the Size of the Relief

1

From the [Relief] menu, click [Relief Size].
The [Relief Size] dialog box appears.

2

Enter the size of the relief and the resolution (the degree
of detail of the relief), then click [OK].

3

The screen at right appears. The white area of the screen
is the where you design the relief.
The screen displayed at this time is called the "2D
screen." It's the screen for typing in text and
creating shapes.
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Creating Shapes and Entering Text
To create a shape, click one of the shape-drawing buttons and
drag.
To enter text, click the text-entry button, then click the location
where you want to insert text. While in this state, type in the text
with the keyboard.
To change the size of a shape or text, refer to "Dr. Engrave Changing the Size and Location of Shapes and Text."

Create a Raised Engraving (Relief)
Add thickness to shapes and text to create a relief.

1
2

Click the shape or text string you want for adding
thickness to select it.

Click the
.
The [Create Relief] dialog box appears.
The dialog box may differ depending on the type of object you selected. The following screen shows the dialog box that appears
when creating a relief of shapes or text.
Make the settings for the required items for creating the relief, then click [OK].

Enter the height of the bottom of the relief.
Enter the thickness of the relief.
These choose the configuration for pushing the
object up (or down).
These choose how to stack the relief.

These choose whether to push down or stack using
the value entered for the relief height.
This is for entering the angle of the base side when
has been selected.
This is for entering the direction of the relief ridge.
You can enter a value when a button other that
has been selected.
When this is selected, the relief of the
chosen object is smoothed.

54

Part 3 Software Guide

3

The display changes automatically to the screen at right,
and a three-dimensional view of the shape of
the relief appears.
This is called the "3D screen," and it displays the shape of
the relief and the tool path. You cannot edit shapes or text.

Creating a Tool Path
A tool path is the path followed by the tool's blade tip. The tool path is generated from the cutting parameters that are presently set.
Before you create the tool path, make the settings for the cutting parameters. At the cutting parameters, make the settings for the composition of the workpiece, the type of tool, and the cutting process.

1

From the [Cut] menu, click [Cutting Parameters].
The [Cutting Parameters] dialog box appears.
Make the settings for the necessary items for cutting, then
click [OK].
This chooses the composition of the cutting material.
This sets the depth for cutting.
This chooses the cutting process.
Make the settings for the tool specifications.

2

Click the
. When the tool path is created, it appears
in pink on the 3D screen.

55

Part 3 Software Guide

Checking the Cutting Results
If Virtual MODELA is installed and set up, then before you perform actual cutting you can check the shape that will be produced after
cutting on the screen.

1

From the [File] menu, click [Output Preview].
Virtual MODELA starts.

2

The cutting data from 3D Engrave is imported into
Virtual MODELA.
An animated display of tool movement appears, and the
shape after cutting is gradually produced.
For more information on how
to operate Virtual MODELA,
see the help for Virtual
MODELA.

Save the Data
Click the
.
The [Save As] dialog box appears.
Enter the name of the file and click [Save].

Start Engraving
Click the
.
When the screen at right appears, click [OK].
Cutting with MDX-500 starts.
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Description of Controls
This opens new file.

This opens an existing file.

This types in the text

This draws the shapes

This saves the file, overwriting the previous data.
This selects a shape or text.
This deletes the selected object and copies it to the
clipboard.

This copies the selected object to the clipboard.

This copies the clipboard data to the screen.

This switches to a flat (two-dimensional) shapeediting screen.

This is used to reposition the vertices of a polygon,
changing its shape.

These are used to retouch imported
images.

This zooms the screen in or out.
The mouse operations for the 2D screen and the
3D screen are different.

This switches to a solid (three-dimensional)
display screen.
Display this screen when you want to check a tool
path or the shape of a relief.

This changes the display location of the object.
This moves the screen display to show areas
outside the window which are not visible.

This adds thickness to shapes, text, images or
other flat objects to create a relief (raised engraving).

This changes the perspective of the relief when
you drag the screen.
This is available only during 3D screen.

This creates a tool path for engraving for the
selected shapes and text.
The tool path for engraving appears on the 3D
screen as a red line.

This command expands or reduces the size of the
object shown to fill the screen.

These select the pen width for
retouching an image.

This creates the path that the tip of the blade traces
(the tool path).
The tool path for cutting appears on the 3D screen
as a pink line.

These change the context of an object.

This outputs the tool path to the MDX-650/500
and starts cutting.

These set the direction of the text string.
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3-3 Cutting Using MODELA Player
This section provides a step-by-step explanation of the basic procedures for cutting a solid objects with MDX-650/500.
In this section, it is assumed that you have already completed making the three-dimensional data for the solid object. It is assumed that
the three-dimensional data you have prepared is three-dimensional data in DXF format.
- Open the three-dimensional data with MODELA Player and set the cutting parameters.
- Install the tool and mount the workpiece on MDX-650/500.
- Set the reference point for cutting.
- Perform surfacing and start cutting.
This explanation takes the sample data for the MODELA programs as an example of a solid object to be cut.

1. Create the Cutting Data
Prepare the data to be cut with MDX-650/500, and set the cutting parameters with MODELA Player.

Open the File

1

From the [File] menu, click [Open...].
The [Open] dialog box appears.

2

Choose the desired file and click [Open].
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Set the Cutting Parameters
The cutting parameters are the parameters for cutting the solid object.
For MODELA Player, make these settings:
Cutting surface
Size
Depth
Workpiece
Cutting process
Tool

: The surface of the solid object to be cut
: The size of the finished object
: The depth of cutting
: The composition of the material to be cut
: The stage of cutting
: The diameter of the blade and the shape of the blade’s tip

* When you set the parameters, the optimal movement speed, cutting-in amount, and so on when performing cutting under these
conditions are selected.
When you use materials and tools for which choices are already available, then unless an incorrect selection is made, there is
practically no chance of the tool breaking. Choose the loaded material and the installed tool.
When you use materials and tools for which choices are not available, the cutting parameters must be entered with great care. An
incorrect setting may result in overload that makes it possible for correct cutting to continue, and in worst cases may cause the tool to
break.

Make the settings for the cutting conditions. Clicking [NEXT] advances the
setting screens in sequence from A to D.
Make the settings in order from A to D.
(Clicking A, B, C, or D in the figure
displays the corresponding setting screen,
this should not be used except when it's
necessary to make settings independently.)

A
B
C
D
This displays the path of
the tool during cutting.

Click here to advance to
the next settings.

A) Select the direction of the object
Select the direction to be used for cutting the object.
In the figure at right, cutting from above is selected.
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B) Set the dimension
Make the setting for object's size. Drag the spin dial up or down,
or click on a number and enter a value from the keyboard.
Clicking [Resize] makes it possible to specify a ratio for the
dimensions.

C) Set the maximum cutting depth
Make the setting for the maximum cutting depth.
Drag the spin dial up or down, or click on a number and enter a
value from the keyboard.
Clicking [Center] sets the depth at a location proportional to the
height.

D) Tool diameter/Material/Finish
Tool
Set the type and diameter of the tool that is installed.
Material
Choose the composition of the loaded material.
Finish
When cutting a solid object on a modeling machine, an attractive
finish can be obtained by first performing rough (draft) cutting,
then performing fine cutting. Set to [Draft] for the first pass, and
to [Fine] for the second pass.
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MODELA Player displays numerical values in 0.1-mm units. When you open a file containing setting values in units
smaller than 0.1 mm, the displayed values are rounded off to the nearest tenth of a millimeter. However, although
MODELA Player displays the values in 0.1-mm units, it uses the original setting values to perform cutting. Also, the
MDX-650/500 can display coordinate values in units of 0.01 mm. This means that the coordinate values displayed
during cutting may differ from the coordinates shown in MODELA Player.

Checking the Cutting Results
If Virtual MODELA is installed and set up, then before you perform actual cutting with MDX-650/500
you can check the shape that will be produced after cutting.

1

From the [File] menu, click [Print Preview].
Virtual MODELA starts.

2

The cutting data from MODELA Player is imported into
Virtual MODELA.
An animated display of tool movement appears, and the
shape after cutting is gradually produced.

* For more information on how to operate Virtual MODELA,
see the help for Virtual MODELA.
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Save the file

1

From the [File] menu, click [Save As...].
The [Save As] dialog box appears.

2

Choose where to save the file, type a filename, and click
[Save]. The file extension is “.mdj”.

2. Install a Tool and Load Material
Refer to "User's Manual 1 - Setup & Maintenance" to install a tool and load material on the MDX-650/500.

3. Set the Z-axis origin point
Set Z0 (the Z-axis origin point) on the surface of the loaded material.
For more information on how to set Z0, see "2-4 Setting the Origin Points (XY Origin Point and Z0) - Setting the Z0 Position."
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4. Determine the Cutting Position
Align the mounted position of the workpiece with the cutting position of the object.

1

From the [Options] menu, click [Layout...].
The [Layout/Surfacing] dialog box appears.

2

The blue rectangle is the size of the object. Drag this area
to set the object’s cutting position.
The lower-left point of the orange rectangle is the X- and
Y-axis origin point for the MDX-650/500.

Blue rectangle

3

Double-clicking on one of the black circles displayed at
the four corners of the object lowers the tool at that
location. This lets you visually confirm the cutting
location.

Black circles
Continue by performing surfacing. See "5 Perform Surfacing" in
the next section.
To make only the setting for the cutting position without performing surfacing, click [OK].
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In addition to the method for determining the cutting position with MODELA Player, there is a method for setting the
X and Y origin point with the MDX-650/500. For more information about how to set the XY origin point, see "2-4
Setting the Origin Points (XY Origin Point and Z0)."
The MDX-650/500's XY origin point (0, 0) corresponds to the lower-left point of the orange rectangle in the
MODELA Player [Layout/Surfacing] dialog box. This means that the maximum cutting range of the MDX-650/500
matches the orange portion only when the selection for [ORIGIN CHANGE] is [UNIT].

When [UNIT] is chosen for [ORIGIN CHANGE]
Maximum cutting range of the MDX-650/500
(orange rectangle)

Machine origin point of the MDX-650/500
(0, 0)

When the XY origin point is set where you want
This portion is displayed on the MODELA
Player screen, but is outside the cutting range.

User origin point on the MDX-650/500
(0, 0)
Maximum cutting range of the MDX-650/500
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5. Perform Surfacing

Do not insert the fingers between
the XY table and base or between
the head and Z cover.

Do not insert the fingers between
the T-slot table and arms or between
the head and Z cover.

Doing so may result in injury.

The fingers may be pinched, resulting in
injury.
Head

Z cover
T-slot table

Arm

Do not wear gloves, a necktie or
wide-sleeved clothing.

Wear dust goggles and mask during
use.

They may become
caught in the tool,
resulting in injury.

Cutting dust may scatter, causing bodily
injury.

Do not operate beyond capacity or
subject the tool to undue force.

Perform dry cutting with no cutting
oil.

The tool may break or fly off in a random
direction. If cutting beyond capacity is
mistakenly started, immediately turn off the
switch.

Such materials can
cause fire.
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This cuts the surface of the loaded workpiece, creating a level surface. This is called “surfacing.”
Surfacing is used to eliminate unevenness in the surface of the workpiece.
When performing surfacing, set the depth-direction reference point to the highest location on the workpiece.
At the MODELA Player [Options] menu, click [Layout...]. The [Layout/Surfacing] dialog box appears.
* Surfacing is not possible unless a file is open.

The slanted-line area is the surfacing range.

Enter the surfacing depth.
This sets the depth from the depth reference
point.

To change the surfacing range, deselect this.
You can change the size by dragging the solid
squares around the slanted-line area. You can
also change the size by entering values in the
[Width] and [Length] text boxes.

When surfacing ends, click [OK].

Click [Start] to begin surfacing. When surfacing finishes, the plane that has been surfaced
is set to the depth-direction reference point.

When surfacing finishes, MODELA Player and the coordinate view on the MDX-650/500 automatically sets Z0 on the surface of the
workpiece after surfacing.

6. Perform Cutting
A three-dimensional object is cut in two stages: draft cutting and finishing.
First pass
Second pass

Draft cutting High-speed cutting that leaves a margin for finishing
Finishing
High-precision cutting of the margin on the workpiece surface left by draft cutting

When finishing ends, cutting is complete.
Depending on the composition of the workpiece, however, finishing may not actual produce an attractive finish.
In such cases, use a file or the like to work it by hand.

Click [START] to start cutting.
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Pausing or stopping operation
While operation is in progress, press the [PAUSE] key.
Movement of the tool and table stops. Note that because this is not
an emergency stop, movement may continue for two or three
seconds before stopping.
The screen at right appears.

PAUSE>CONTINUE
STOP

To continue with cutting
Turn the dial to move the arrow to [CONTINUE], then press the
[ENTER] key.

PAUSE>CONTINUE
STOP

To end cutting
Stop sending data from MODELA Player.

1

Click [Start].
Point to [Settings...] and click [Printers].

2

Double-click the [Roland MODELA MDX-500 (RML-1)]
icon.

3

At the [Printer] menu, choose [Purge Print Jobs] or
[Cancel] to stop sending data.
If you're using Windows 2000, choose [Cancel All
Documents].

4

Turn the dial to move the arrow to [STOP], then press the
[ENTER] key.

NOTICE

PAUSE>STOP
X/Y CUT SPEED

Depending on the model and the settings of the computer you’re using, data transmission may not stop
immediately, and the MDX-650/500 may operate.
If this happens, then either wait until operation has definitely stopped, or press the [PAUSE] key, move the
arrow to [STOP], then press the [ENTER] key.

67

Part 4 User's Reference

Part 4 User's Reference
4-1 Cutting Area
MDX-650
The maximum cutting area of the MDX-650 is 650 mm x 450 mm x 155 mm (25-9/16 in. x 17-11/16 in. x 6-1/16 in.). If you selected
RML-1 as the command set, then when converted to coordinate values (step size: 1/100 mm), (x, y, z) = (50,000, 33,000, 10,500).
The actual cutting area of the MDX-650 differs according to the type of spindle installed.

When Use the High-torque Spindle (ZS-650T)
When a high-torque spindle (ZS-650T) is installed, the range that you can actually cut (in the height direction) is subject to the following
restrictions and is smaller than the maximum cutting range described earlier.

105 mm
(4-1/8 in.)
80 mm
(3-1/8 in.)

22 mm
(7/8 in.)

155 mm(6-1/16 in.)
(Z-axis movable range)

- Length of the installed tool
- Position of the XY table where the workpiece to cut is loaded
- If using a spacer for the T-slot table (ZA-600/500 series), the height of the spacer

X-rail bottom
surface

T-slot table upper
surface when
using a spacer
(ZA-508)

T-slot table
upper surface
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When Use the High-speed Spindle
When a high-speed spindle is installed, the range that you can actually cut (in the height direction) is subject to the following restrictions
and is smaller than the maximum cutting range.
- Length of the installed tool
- Position of the XY table where the workpiece to cut is loaded
- If using a spacer for the T-slot table (ZA-600/500 series), the height of the spacer
- If using a depth regulator nose, the stroke of the spindle due to the nut (approx. 5 mm)

130 mm
(5-1/8 in.)

55 mm
(2-3/16 in.)

112 mm
(4-3/8 in.)

155 mm(6-1/16 in.)
(Z-axis movable range)

If not using the depth regulator nose
(nut tightened)

12 mm
(1/2 in.)

94.6 mm
(3-3/4 in.)
5.4 mm
(3/16 in.)

155 mm(6-1/16 in.)
(Z-axis movable range)

If using the depth regulator nose
(nut loosened)

X-rail bottom
surface

T-slot table upper
surface when
using a spacer
(ZA-613)

T-slot table
upper surface
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MDX-500
The maximum cutting area of the MDX-500 is 500 mm x 330 mm x 105 mm (19-5/8 in. x 12-15/16 in. x 4-1/8 in.). If you selected RML1 as the command set, then when converted to coordinate values (step size: 1/100 mm), (x, y, z) = (50,000, 33,000, 10,500).
The actual cutting area of the MDX-500 differs according to the type of spindle installed.

When Use the High-torque Spindle (ZS-500T)
When a high-torque spindle (ZS-500T) is installed, the range that you can actually cut (in the height direction) is subject to the following
restrictions and is smaller than the maximum cutting range described earlier.

55 mm
(2-3/16 in.)
80 mm
(3-1/8 in.)

22 mm
(7/8 in.)

105 mm (4-1/8 in.)
(Z-axis movable range)

- Length of the installed tool
- Position of the XY table where the workpiece to cut is loaded
- If using a spacer for the T-slot table (ZA-600/500 series), the height of the spacer

X-rail bottom
surface

T-slot table upper
surface when
using a spacer
(ZA-508)

T-slot table
upper surface
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When Use the High-speed Spindle
When a high-speed spindle is installed, the range that you can actually cut (in the height direction) is subject to the following restrictions
and is smaller than the maximum cutting range.
- Length of the installed tool
- Position of the XY table where the workpiece to cut is loaded
- If using a spacer for the T-slot table (ZA-600/500 series), the height of the spacer
- If using a depth regulator nose, the stroke of the spindle due to the nut (approx. 5 mm)

80 mm
(3-1/8 in.)

55 mm
(2-3/16 in.)

62 mm
(2-7/16 in.)

105 mm (4-1/8 in.)
(Z-axis movable range)

If not using the depth regulator nose
(nut tightened)

12 mm
(1/2 in.)

44.6 mm
(1-3/4 in.)
5.4 mm
(3/16 in.)

105 mm (4-1/8 in.)
(Z-axis movable range)

If using the depth regulator nose
(nut loosened)

X-rail bottom
surface

T-slot table upper
surface when
using a spacer
(ZA-508)

T-slot table
upper surface
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4-2 Coordinate System
The MDX-650/500 employs three separate coordinate systems (described below) according to the application or purpose of use.

Machine Coordinate
Under the machine coordinate system, the coordinates are
determined mechanically against the MDX-650/500. This system
forms the basis of the "work coordinates" which is explained later.
When [Go LIMIT Pos.] is chosen for [MECHA MOVING] on the
display menu, the point to which the unit moves is the origin of
the machine-coordinate system (x, y, z) = (0, 0, 0). (The origin is
fixed.)
The machine coordinate system basic unit is fixed as one step = 1/
100 mm (0.00039 in).

Z
Y
X

The origin of
the machine
coordinate

Work Coordinate
The origin of the machine coordinate system is fixed, but there is a
coordinate system in which the origin can be moved relative to the
machine coordinate system. This system is called the work
coordinate system.
In the work coordinate system, the home position is the XY origin
and Z0 is the Z axis origin. The origin of the work coordinates
can be set by setting the XY axis origin and Z0 (the Z axis origin).
The origin of the work coordinates is the standard point for cutting
against the attached workpiece.
The work coordinate system basic unit is fixed as one step = 1/100
mm (0.00039 in).
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4-3 Operating Each Function
Changing to Japanese Messages on the Liquid-crystal Display
You can choose either English or Japanese for the display language.

1

Switch on the power while holding down the [EXIT] key.

2

Turn the dial to move the arrow to [JAPANESE], then
press the [ENTER] key.

3

Messages on the display now appear in Japanese.

>2 JAPANESE
-<END>-

* To return the display to English-language messages, carry out Step 1 again. When the language-selection menu appears
(similar to the one in Step 1, but in Japanese), move the arrow to “English” and press the [ENTER] key.

Performing Repeat Cutting
The data buffer is the place where data received from the computer is stored temporarily. (The data in the data buffer can be erased by
switching off the power or clearing the data.
Pressing the [COPY] key calls up the all cutting data stored in the MDX-650/500's data buffer and executes the replotting procedure.
When you perform replotting, clear the data from the data buffer before sending the cutting for replotting from the computer.

1

Press the [COPY] key.
The screen at right appears.

>1 COPY START
2 CLEAR COPY BUFFER

2

Turn the dial to move the arrow to [CLEAR COPY
BUFFER], then press the [ENTER] key.
Cutting data in the data buffer is lost.

>2 CLEAR COPY BUFFER
-<END>-
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3

Install the tool (blade) and load the material. Use the
software to send the cutting data.

4

After cutting has finished, remove the cut material and
load a new piece. Set the origin point if necessary.

5

Press the [COPY] key.
Turn the dial to move the arrow to [COPY START], then
press the [ENTER] key.

>1 COPY START
2 CLEAR COPY BUFFER

Changing the Feed Rate or Spindle Speed During Cutting
The feed rate and spindle rotating speed set by the software can be changed while cutting is in progress.
This is done by first pausing the MDX-650/500 during cutting, then changing the feed rate or spindle rotating speed. However, if the
computer subsequently sends a command to change the feed rate or spindle rotating speed, the setting will change as specified by the new
command. When set by software or set directly on the MDX-650/500, the setting made last takes precedence.
The following method is appropriate for making delicate halfway adjustments to conditions previously set using software, etc.
For more information about the spindle-motor speed and the feed rate, refer to "2-3 Setting the Cutting Conditions."
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While operation is in progress, press the [PAUSE] key.
Movement of the tool and table stops. Note that because
this is not an emergency stop, movement may continue
for two or three seconds before stopping.
The screen at right appears.

PAUSE>CONTINUE
STOP
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2

Turn the dial to move the arrow to the item you want,
then press the [ENTER] key.

PAUSE>X/Y CUT SPEED
Z DOWN SPEED

3

Turn the dial to change the value, then press the [ENTER]
key.
To change another item, press the [EXIT] key, then repeat
steps 2 and 3.

PAUSE:X/Y CUT SPEED
< 2 mm/s>

4

Press the [EXIT] key to return to the screen at right.

PAUSE>CONTINUE
STOP

5

Turn the dial to move the arrow to [CONTINUE], then
press the [ENTER] key.
The paused state is canceled and cutting resumes.

* You can also change the spindle speed while cutting is in progress by turning the dial. Note that the changed spindle speed is in effect
only during cutting.

Stopping the Cutting Process
If you want to change the shape to cut and redo cutting from the beginning, or if the data was different from what you wanted to cut, then
follow the steps below to stop operation.

1

While operation is in progress, press the [PAUSE] key.
Movement of the tool and table stops. Note that because
this is not an emergency stop, movement may continue
for two or three seconds before stopping.
The screen at right appears.

2

Stop sending data from the computer

3

Stop execution of the program.

PAUSE>CONTINUE
STOP

PAUSE>STOP
X/Y CUT SPEED
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4-4 Descriptions of the Display Menus
1 SPEED OVER RIDE
1-1 X/Y CUT SPEED
1-1 X/Y CUT SPEED
< 2 mm/s>

Stored in Memory
Yes

Description
This sets the feed rate along the X and Y axes during cutting.
For details, see "2-3 Cutting Condition Setting".

Factory Default
2
Setting Range
0.5, 1 to 85
Steps
1

1-2 Z DOWN SPEED
1-2 Z DOWN SPEED
< 2 mm/s>

Stored in Memory
Yes

Description
This sets the feed rate along the Z axis during cutting.
For details, see "2-3 Cutting Condition Setting".

Factory Default
2
Setting Range
0.5, 1 to 85
Steps
1

1-3 X/Y MOVE SPEED
1-3 X/Y MOVE SPEED
< 85 mm/s>

Stored in Memory
Yes
Factory Default
85
Setting Range
0.5, 1 to 85
Steps
1
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Description
This sets the speed of movement along the X and Y axes when the tool
is raised.
For details, see "2-3 Cutting Condition Setting".

Part 4 User's Reference

1-4 Z UP SPEED
1-4 Z UP SPEED
< 85 mm/s>

Stored in Memory
Yes
Factory Default
85

Description
This sets the speed of movement along the Z axis when the tool is
raised.
For details, see "2-3 Cutting Condition Setting".

Setting Range
0.5, 1 to 85
Steps
1

2 SPINDLE RPM
2 SPINDLE RPM
< 5000 RPM>

Stored in Memory
Yes

Description
This specifies the spindle speed.
For details, see "2-3 Cutting Condition Setting".

Factory Default
3000
(High Torque)
5000
(High Speed)
Setting Range
3000 to 12000
(High Torque)
5000 to 20000
(High Speed)
Steps
100

3 MECHA MOVING
3 >1 Go ORIGIN Pos.
2 Go Z0 Pos.

3

Description
This moves the tool to the specified location.

9 Go LIMIT Pos.
10 To Main MENU
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4 ORIGIN CHANGE
4 ORIGIN

CHANGE
<USER>

Stored in Memory
Yes
Factory Default
USER

Description
This specifies the location of the origin point for the X and Y axes.
For details, see "2-4 Setting the Origin Points (XY Origin Point and
Z0)".

Selection Choices
USER, LIMIT,
CENTER

5 MOVING MODE
5-1 SPINDLE CONTROL
5-1 SPINDLE CONTROL
<ON>

Stored in Memory
Yes

Description
This chooses the method of control for the spindle motor.
ON

When a command to rotate the spindle is received, a
rotate signal is issued to the internal spindle. A signal is
also issued to the EXT2 connector at the same time.

Selection Choices
ON, OFF,
EXTERNAL
ONLY

OFF

Even when a command to rotate the spindle is received,
not rotate signal is issued to the internal spindle circuit.
Similarly, no signal is issued to the EXT2 connector.

Stored in Memory
Yes

Description

Factory Default
ON

EXTERNAL ONLY Even when a command to rotate the spindle is received,
not rotate signal is issued to the internal spindle circuit.
A signal is issued only to the EXT2 connector.

5-2 OVER AREA
5-2 OVER AREA
<CONTINUE>

Factory Default
CONTINUE
Selection Choices
CONTINUE,
PAUSE

This selects the action when the tool returns from a coordinate outside
the cutting range to a coordinate inside the range. (The tool cannot
actually be moved outside the cutting range, but the MDX-650/500's
internal processing handles this as if it had.)
CONTINUE Operation is not paused upon return to the cutting
range. Cutting continues without interruption.
PAUSE
Operation is paused when the tool returns to the
cutting range.

"CONTINUE"

1

"PAUSE"

Cutting Area
(500 mm x 330 mm)

Cutting Area
(500 mm x 330 mm)

(9-13/16 x 5-7/8 in.)

(9-13/16 x 5-7/8 in.)

2

Operation continues

1

2

Operation is paused
: Tool path
: Coodinate point
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5-3 SMOOTHING
5-3 SMOOTHING
<ON>

Stored in Memory
Yes
Factory Default
ON

Description
Smoothing is a function for cutting smooth arcs and circles. This
selects the type of smoothing. Smoothing can also be switched off.
When shipped from the factory, this is set to [ON.] If arcs cannot be
cut well using this setting, try changing it to [OFF.]

Selection Choices
OFF, ON

5-4 ACCELERATION
5-4 ACCELERATION
<0.3G>

Stored in Memory
Yes
Factory Default
0.3

Description
This chooses the acceleration when moving the tool and table.
Normally the default value (0.3 G) can be left unchanged. When
cutting material that creates a high load, on rare occasions the
acceleration may make it impossible to perform cutting. In such cases,
the value should be changed.

Selection Choices
0.05, 0.1, 0.3

6 COMMAND SET
6 COMMAND SET
<AUTO>

Stored in Memory
Yes
Factory Default
AUTO
Selection Choices
MODE-1,
MODE-2,
AUTO

Description
This selects the RML-1 command mode. When set to [AUTO,]
[MODE-1] or [MODE-2] is determined automatically. If automatic
determination is not made correctly, find out what instruction system
the application software (or driver software) uses for data that is sent,
and change this setting to [MODE-1] or [MODE-2.] To determine
which mode your software is sending data in, refer to the documentation for the software.

7 CONNECTION
7 CONNECTION
<AUTO>

Stored in Memory
Yes
Factory Default
AUTO
Selection Choices
AUTO, SERIAL,
PARALLEL

Description
This sets the type of interface used for connection to the computer.
When set to [AUTO], the port is determined automatically. The
communication parameters in effect when a serial connection is used
are according to the parameters of the panel settings.
If the interface cannot easily be determined when set to [AUTO], the
setting should be made manually.
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8 SERIAL PARAMETER
8-1 STOP BIT
8-1 STOP BIT
<1>

Stored in Memory
Yes

Description
This sets the number of stop bits for the communication parameters.

Factory Default
1
Selection Choices
1, 2

8-2 DATA BIT
8-2 DATA BIT
<8>

Stored in Memory
Yes

Description
This sets the data bit length for the communication parameters.

Factory Default
8
Selection Choices
7, 8

8-3 PARITY BIT
8-3 PARITY BIT
<NONE>

Stored in Memory
Yes

Description
This makes the setting for parity checking for the communication
parameters.

Factory Default
NONE
Selection Choices
NONE, ODD,
EVEN

8-4 BAUD RATE
8-4 BAUD RATE
<9600>

Stored in Memory
Yes
Factory Default
9600
Selection Choices
4800, 9600,
19200, 38400
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Description
This sets the bit rate (transmission speed) for the communication
parameters.
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8-5 HAND SHAKE
8-5 HAND SHAKE
<HARD-WIRE>

Stored in Memory
Yes

Description
This sets the type of hand shake for the communication parameters.

Factory Default
HARD-WIRE
Selection Choices
HARD-WIRE,
XON/XOFF

9 COMPENSATE
9-1 X-COMPENSATE
<100.00 %>

Stored in Memory
Yes

9-2 Y-COMPENSATE
<100.00 %>

Factory Default
100

9-3 Z-COMPENSATE
<100.00 %>

Setting Range
99.90 to 100.10

Description
This compensates for differences between the length specified by the
program and the actual cutting length. This can correct for error due to
temperature or humidity, as well as error due to individual differences
from one machine to another.
If you change the compensation value, then switch the power off and
back on. The changed compensation value is enabled after the power
has been reset.

Steps
0.01

10 OTHERS
10-1 SENSOR MODE
Description

10-1 SENSOR MODE
Please Cursor Move

The Z0 sensor included with the unit is used to set the Z0 point on the
surface of the workpiece.
For details, see "2-4 Setting the Origin Points (XY Origin Point and
Z0). - Setting Z0 with the Z0 Position Sensor".

10-2 SPINDLE UNIT
10-2 SPINDLE UNIT
<HIGH TORQUE>

Stored in Memory
Yes
Factory Default
HIGH TORQUE

Description
This sets the type of the installed spindle to MDX-650/500.
If a high-torque spindle is installed, choose [HIGH TORQUE]. If a
high-speed spindle is installed, choose [HIGH SPEED].

Selection Choices
HIGH TORQUE,
HIGH SPEED
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10-3 BUZZER
10-3 BUZZER
<ON>

Stored in Memory
Yes

Description
This switches on or switches off the confirmation sound heard when a
control key is pressed.

Factory Default
ON
Selection Choices
ON, OFF

10-4 SENSOR HEIGHT
10-4 SENSOR HEIGHT
<15000 um>

Stored in Memory
Yes
Factory Default*
15000

Description
The thickness of the Z0 sensor can vary slightly due to conditions of
temperature or humidity. This allows the sensor thickness to be
adjusted to match actual thickness.
* The value that is set when shipped from the factory varies from one
MDX-650/500 unit to another .

Setting Range
0 to 30000
Steps
10

10-5 REVOLUTION TIME
10-5 REVOLUTION TIME
0 Hour

Description
This displays the total rotation time of the spindle. The rotation time
cannot be returned to [0] (zero).
The displayed time should be used as an indicator for performing
periodic maintenance. (For more information about maintenance,
refer to the separate "Setup & Maintenance.")

11 SELF MODE
11-1 SURFACE CUT
11-1 SURFACE CUT
Are You Sure?[ENTER]
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Description
This menu item is for performing surfacing of the vacuum plate on the
optionally available ZV-500A vacuum table. For more information,
refer the User's Manual for the ZV-500A vacuum table.
* This menu item must not be used to perform surfacing for a
workpiece.
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12 Rotary Control
12 ROTARY CONTROL

Description
This menu item is available when you are employ the optional rotary
axis unit. If the rotary axis unit is not installed, you cannot enter this
menu.

13 To Coordinate
*X
Z

0
0

Y
0
5000 RPM

Description
This displays the current tool location and spindle speed.
The units of measurement are in machine steps (1 step = 0.01 mm).
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4-5 What to Do If...
When the MDX-650/500 does not work...
Is operation paused?

Cancel the paused state.

Is the power for the MDX-650/500 switched on?

Make sure the MDX-650/500 is powered up.

Is NC code chosen as the command set?

Set the command set to RML-1. For more information about how to
make the setting, see "Introduction" in this manual.

When the spindle does not rotate ...
Is the SPINDLE COVER open?

Close the SPINDLE COVER.

Is [SPINDLE CONTROL] set to [OFF] or [EXTERNAL ONLY]?

Refer to "Descriptions of the Display Menus" and change the setting
for "SPINDLE CONTROL" to "ON."

Data cannot be sent
When using a serial connection, do the communication parameters for MDX-650/500 match the settings
for the computer?

Refer to “2-2 Setting the Connection Parameters” to make the correct
settings.

Has the connection cable come loose?

Make sure the connection cable is plugged in securely with no
looseness at either end.

Is the correct connection cable being used?

The type of connection cable varies according to the computer being
used. Also, some application software requires the use of a special
cable. Make sure the correct cable is being used.

Is the correct output device set for the application or driver software?

Refer to the manual for the application or driver software to set the
output device correctly.
If you're using the included "2.5D DRIVER," refer to "Part 1 Installing the Software."

The power does not come on...
Has the power cord come loose?
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Make sure the power cord is plugged in securely with no looseness at
either end.
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The message "Unusable Parameter" appears and
operation stops
This appears when a specified parameter value is out of range.
In particular, this appears when the tool-down position (Z1) is set at a lower location than the Z-axis cutting range (105 mm).
When cutting material of uneven thickness using the depth regulator nose, set the tool-down position at a lower height than the actual
cutting depth (see "User's Manual 1 - Setup & Maintenance"). As a result, the tool-down position (Z1) is set at a location lower than the
Z-axis cutting range (105 mm).
To clear the error message, switch off the power.
To avoid errors, place a flat board under the workpiece to serve as a lifting base.

Changes to the feed rate and rotating speed of the
spindle motor made while cutting is in progress do not
take effect
Even when the MDX-650/500 is paused during cutting and the setting for the spindle rotating speed or feed rate is changed using the
display menus, the changed setting may not take effect.
This is due to the following causes.
- After the setting was changed, a command for spindle rotating speed or feed rate contained in data already sent was executed.
- After the setting was changed, a command changing the spindle rotating speed or feed rate was sent from the computer.
In such cases, change the setting on the computer.

The expected cutting precision is not obtained
The expected cutting precision may not be obtained when the cutting parameters and the end mill do not match.
This is due to the following causes.
- The amount of blade extension for the end mill is too long.
- The shank diameter of the blade is too narrow with respect to the cutting parameters.
In such cases, change the cutting parameters (the end mill's amount of blade extension or shank diameter) to match the object being cut.
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4-6 Error Messages
An error message appears when the data being sent contains an error explained under "Description" in the table. However, only information about the error appears on the display -- sending of data is not stopped, and the next operation is not prevented.
Pressing the [ENTER] key clears the error message from the display and pauses operation.
If an error occurs, correct cutting may become impossible. We recommend that you stop cutting and check the settings.

Error message
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Description

Command Not
Recognized

Appears if an instruction that the MDX-650/500 cannot interpret is sent. This error is generated
if an instruction from the [MODE-2] set is sent when the unit has been set to recognize [MODE1,] or viceversa. Change the setting for the recognized instruction set, using the control panel,
and this error should no longer occur.

Wrong Number
of Parameters

Appears if the number of parameters differs from the permissible number.

Bad Parameter

Appears if the value specified for a parameter is out of the permissible range.

Unknown
Character set

Appears if an unusable character is specified.

Position Overflow

Appears if coordinates being overflowed.

Buffer Overflow

Appears if the polygon buffer is full.

I/O Err: Output
Request Overlap

Appears if an output instruction is sent from the computer during execution of a previous output
instruction. More precisely, there is a certain amount of delay between the moment an output
instruction is given and the instant actual output begins. This error message appears if the new
output request arrives during this delay time. (The delay time can be set using the [ESC].M
instruction.)

I/O Err: Command
Not Recognized

Appears if a device control instruction that the MDX-650/500 cannot interpret is sent.

I/O Err: Wrong
Parameter

Appears if an invalid parameter has been specified for a device control instruction.

I/O Err: Out of
Parameter range

Appears if the value for a device control instruction parameter exceeds the permissible limit.

I/O Err:Termination
Error

Appears if the number of parameters for a device control instruction is more than that permissible.
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Error message

Description

I/O Err:Framing/Parity Error

Appears if a framing error, parity error, or overrun error occurs at the time of data reception.
(There is a problem with one of these settings: Baud Rate, Parity, Stop Bits, or Data Bits. The
protocol settings for the MDX-650/500 must be made correctly in order to match the settings
your computer is set to use.)

I/O Err: Buffer
Overflow

Appears if the I/O buffer has overflowed. (There is a problem with the connecting cable, or the
settings for Handshaking. Make sure you are using a cable appropriate for the computer being
used. Also, check that the setting for Handshaking is correct.)

I/O Err:Indeterminate Error

Appears if an undefined communication error occurs.
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4-7 Other Messages
Besides error messages related to commands or communication parameters, the following messages may also appear on the display.

Error message

EMERGENCY STOP
EXT1 IS NOT CONNECT

This appears when either the cable connecting the safety cover and the main unit or the key
connector is disconnected.
Switching off the power clears the message.
Make the connections correctly, then switch on the power.

EMERGENCY STOP
MOTOR LOCK
XYZS

The MDX-650/500 stops automatically if an excessive load is placed on the spindle or the X, Y,
or Z axis during cutting. The message shown at left appears at this time.
Switching off the power clears the message.
The overload may be due to excessive hardness of the material, an excessive amount of cuttingin, a feed rate that is too fast, or operation being impeded by cuttings. Take action such as
changing the cutting parameters or cleaning the machine to eliminate the cause of the over load.

EMERGENCY STOP
SP/SFTY COVER OPEN

This appears when the spindle cover or the safety cover is opened during operation.
SP: Spindle cover
SFTY: Safety cover
Switching off the power clears the message.
Close the covers, then switch on the power.

CAUTION!
SP
COVER OPEN
10-1 SENSOR MODE
Please Cursor Move

10>1 SENSOR MODE
Z0SENSOR NOTHING
10>1 SENSOR MODE
SET Z ORIGIN!
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Description

This appears when the spindle cover is opened during standby.
SP: Spindle cover
Closing the cover clears the message and returns the display to the coordinate view screen.
This appears when the sensor mode is entered.

This error appears if the Z0 sensor is not connected when entering the sensor mode.
The display shows the message for several seconds, then returns to the previous screen.
Connection the Z0 sensor before entering the sense mode.
This appears when Z0 is set in the sensor mode.

Comp. Effect After
Power On Again

This appears when the value for [COMPENSATE] is changed.
After setting the distance compensation value, switch the power off and on again to activate the
change.

CAN'T COPY
TOO BIG DATA

When the amount of cutting data exceeds the capacity of the MDX-650/500’s data buffer, this
message appear when an attempt is made to perform recutting with this data. The data cannot all
fit in the MDX-650/500’s data buffer, so repeat cutting cannot be performed.

CAN'T COPY
BUFFER EMPTY

This message appears if repeat cutting is attempted when the data buffer is empty. Send cutting
data before performing repeat cutting.
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Error message

CAN'T COPY
COVER OPEN

Description
This appears when the [COPY] key is pressed to attempt to perform copying while the spindle
cover or the safety cover is open.
Closing the cover pauses operation. To perform copying, choose [CONTINUE]. To stop
copying, choose [STOP].
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4-8 List of RML-1 Instructions
* 1 : -(223-1) to +(223-1)

mode1
Instruction

Format

Parameter

Range [Default]

@

Input Z1 & Z2

@ Z1, Z2

Z1

Position on Z1

-10500 to 0 [0]

Z2

Position on Z2

0 to +10500 [0]

H

Home

H

None

D

Draw

D x1, y1, x2, y2, ..... , xn, yn

xn, yn

Absolute coordinate

*1

M

Move

M x1, y1, x2, y2, ..... , xn, yn

xn, yn

Absolute coordinate

*1

I

Relative Draw

I x1, y1, x2, y2, ..... ,

xn, yn

Relative coordinate

*1

xn, yn

Relative coordinate

*1

xn, yn
R

Relative Move

R x1, y1, x2, y2, ..... ,
xn, yn

V

Velocity Z-axis

Vf

f

Feed rate for Z axis

0 to 85 [mm/sec] [2 [mm/sec]]

F

Velocity X,Y-axis

Ff

f

Feed rate for X and Y axis

0 to 85 [mm/sec] [2 [mm/sec]]

Z

XYZ-axis

Z x1, y1, z1, ..... , xn, yn, zn

xn, yn

XY coordinate

*1

Simultaneous Feed

Z x1, y1, z1, ..... , xn, yn, zn

zn

Z coordinate

*1

W

Dwell

Wt

t

Dwell time

0 to 32767 [msec] [2 [msec]]

^

Call mode2

^ [mode2] [parameter].....
[parameter] [;]

mode2
Instruction

Format

Parameter

DF Default

DF;

None

IN

Initialize

Range [Default]

IN;

None

PA Plot Absolute

PA x1, y1 (,x2, y2, ..... , xn, yn);

xn, yn

Absolute XY coordinate

*1

PD Pen Down

PD x1, y1 (,x2, y2, ..... , xn, yn);

xn, yn

XY coordinate

*1

Relative XY coordinate

*1

xn, yn

XY coordinate

*1

s

Feed rate for X and Y axis

0 to 85 [mm/sec] [2 [mm/sec]]

PA;

PD;
PR Plot Relative

PR x1, y1 (, x2, y2, ..... ,

xn, yn

xn, yn);
PR;
PU Pen Up

PU x1, y1 (,x2, y2, ..... , xn, yn);
PU;

VS Velocity select

VS s;
VS;
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mode1, mode2 common instruction
Instruction

Format

Parameter

!DW Dwell

!DW t [terminator]

t

Dwell time

0 to 32767 [0]

!MC n [terminator]

n

Motor ON/OFF switching

-32768 to 32767 [motor ON]

Z1 coordinates

-10500 to 0 [0]

!MC Motor Control

Range [Default]

!MC [terminator]
!NR Not Ready

!NR [terminator]

None

!PZ Set Z1&Z2

!PZ z1 (,z2) [terminator]

z1
z2

Z2 coordinates

0 to 10500 [0]

!RC Revolution

!RC n [terminator]

n

Spindle motor

0 to 15

revolution speed
!VZ Velocity Select

!VZ s [terminator]

s

Feed rate (Z axis)

0 to 85 [mm/sec] [2 [mm/sec]]

Z-axis
!ZM Z-axis Move

!ZM z [terminator]

z

Z coordinate

-10500 to 0

!ZO Set Z0

!ZO z [terminator]

z

Z machine coordinate

-10500 to 0

!ZZ XYZ-axis

!ZZ x1, y1, z1, .....,

xn, yn

XY coordinate

*1

zn

Z coordinate

*1

!ZE Xx1, Yy1, Zz1, Aa1, Xx2, .....,

XY, Z, A

Axis name (alphabet)

A to Z or a to z

Xxn, Yyn, Zzn, Aan [terminator]

xn, ynzn

Coordinate

*1

Simultaneous Feed
!ZE Extention Axis Move

zn
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4-9 Device Control Instructions
The Device Control instructions determine how communication between the MDX-650/500 and the computer will be handled using the
RS-232C interface; and also are employed when relaying to the computer the status of the MDX-650/500. Some of them can be used to
format the output for RML-1 instructions.
A Device Control instruction is composed of three characters: ESC (1Bh), a ".", and an uppercase letter. There are also two types of
device control instructions: one carries parameters and the other does not.
Parameters can be omitted. Semicolons, " ; " are used as separators between parameters. A semicolon without parameters means that
parameters have been omitted. Device Control instructions with parameters require a terminator to indicate the conclusion of the
instruction. A colon " : " is used as the terminator, and it must not be omitted.
No terminator is necessary for Device Control instructions without parameters.

Instruction

Format

Parameter

Range

([ ] is default) Explanation

Handshake Instructions
ESC .B

[ESC].B

None

[ESC].M<P1>;<P2>;

P1: Delay time

Outputs the current remaining buffer capacity to

Buffer Capacity
ESC .M
Set Handshake

the Output Remaining computer.

<P3>;<P4>;<P5>;<P6>:

0-32767 (msec)

Sets handshake output specifications.

[0 (msec)]

Output

P2: Output trigger character

[0 (Sets nothing)]

Specifications (1)

P3: Echo terminator

[0 (Sets nothing)]

P4: Output terminator

[13 ([CR])]

P5: Output terminator

[0 (Sets nothing)]

<P5>, always set 0 to <P6>. When you specify

P6: Output initiator

[0 (Sets nothing)]

some value to <P6>, always set 0 to <P5>.

P1: Intercharacter delay

0-32767 (msec)

Sets an intercharacter delay, and also an Xoff

[0 (msec)]

character for performing the Xon/Xoff handshake.

ESC .N

[ESC].N<P1>;<P2>;

Set Handshake
Output

<P3>; ••••• ;<P11>:

Specifications (2)

P2-P11

Note: When you specify some values to <P4> and

[All 0 (Sets nothing)]

: Xoff character
(for Xon/Xoff)
Immediate response
character
(for ENQ/ACK)

ESC .H
Sets ENQ/ACK
Handshake Mode1

[ESC].H<P1>;<P2>;
<P3>; •••••••• ;<P12>:

P1: The number of bytes 0-15358 (byte)
for data block

[80 (byte)]

compares the value set by <P1> and the remaining

P2: ENQ character

[0 (Sets nothing)]

buffer capacity, and returns the ACK character to

P3-P12

[All 0 (Sets nothing)]

: ACK character (only
when <P2> is set)
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When receiving the ENQ character set by <P2>,

the host computer when the remaining buffer
capacity is larger. The [ESC].H with no parameter
performs a dummy handshake.
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Instruction

Format

Parameter

Range

ESC .I

[ESC].I<P1>;<P2>;

P1: Limit of the remaining

0-15358 (byte)

buffer capacity

[80 (byte)]

Set Xon/Xoff

<P3> ; •••••••• ;<P12>:

Handshake and

([ ] is default) Explanation
Used for performing the Xon/Xoff handshake and
the ENQ/ACK handshake mode 2.

(for Xon/Xoff)

The [ESC].I instruction with no parameter performs

ENQ/ACK

The number of data

a dummy handshake. In a dummy handshake,

Handshake Mode2

block bytes (for ENQ/

always returns the ACK character to the host

ACK (mode2))
P2: ENQ character

computer, regardless of the remaining buffer
[0 (Sets nothing)]

capacity, when receiving the ENQ character.

(for ENQ/ACK (mode2))
0 (for Xon/Xoff)
P3-P12

[All 0 (Sets nothing)]

: Xon character (for Xon/Xoff)
ACK character
(for ENQ/ACK (mode2))
ESC .@

[ESC].@ P1;P2:

Controls DTR

P1: Ignored
P2: DTR signal control

Controls the DTR signal (No. 20 pin of RS-232C).
0-255

[1]

An even number parameter (e.g. 0) always sets the
DTR signal to High without performing the
hardware handshake. An odd number parameter
(e.g. 1) performs the hardware handshake and
controls the DTR signal according to the remaining
buffer capacity.

Status Instructions
ESC .O

[ESC].O

None

Outputs the status codes of MDX-650/500 shown

in
Outputs the Status
of Buffer, Pause

the table below.
Code
0
8
16

24

Meaning
Data remaining in buffer.
Buffer empty.
Data remaining in buffer. MDX-650/500
being paused
(Pause On being displayed).
Buffer empty. MDX-650/500 being
paused (Pause On being displayed).
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Instruction

Format

Parameter

ESC .E

[ESC].E

None

Range

([ ] is default) Explanation
Outputs an error code related to RS-232C interface

Output RS-232C

(see the table below), and clears the error

Error Code

simultaneously. At the same time, the error being
displayed is canceled.
Error Possible cause and action
code
0
No I/O errors
10
Cause: after execution of an output
command, other output instructions are
sent before the output was not completed.
Action: let the computer to read the MDX500 output by the output instruction
and then send another output instruction.
11
Cause: an error occurs in a device
control instruction.
Action: correct your program.
13
Cause: parameters are overflowing.
Action: correct your program.
14
Cause: the number of the parameters set
is more than specified or a colon ‘:’ was
not used to terminate.
Action: correct your program.
15
Cause: framing error, parity error or overrun error at the time of data receipt .
Action: match the communication
protocols of both computer and MDX650/500 (baud rate, data bit length,
stop bit length).
16
Cause: the I/O buffer overflows.
Action: This error does not occur when
hardware handshake is performed, but
may occur when software handshake is
performed. If this error occurs, check the
remaining buffer capacity of the MDX650/500 and send less data than the
remaining buffer capacity.

ESC .L

[ESC].L

None

MDX-650/500 outputs the size of the I/O buffer to

Output I/O buffer

the computer when receiving this instruction.

size

It usually outputs 1024 (bytes).

Abort Instructions
ESC .J

[ESC].J

None

Abort Device

Aborts both the currently executed device control
instruction and output.

Control Instruction
ESC .K

[ESC].K

None

Continues to execute the RML-1 instruction

Abort RML-1

in operation, aborts other incoming RML-1

Instruction

instructions and clears the data buffer.

ESC .R

[ESC].R

None

Initializes all settings established by the device

Initialize Device

control instructions. Execution of [ESC].R brings

Control Instruction

the same states as the following device control
instructions are executed.
[ESC].J, [ESC].M:, [ESC].N:, [ESC].H:,
[ESC].I: and [ESC].@:
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4-10 Display Menus Flowchart
MDX-650
Switch on the power while
holding down the [EXIT] key

POWER ON
MDX-650
Roland DG Corp.

Hit "ENTER" >RML-1
Select MODE NC-CODE

1 ENGLISH
>2 JAPANESE

Select "ENGLISH"

-<END>-

[ENTER]

Select "RML-1"

[ENTER]

MODE
: RML-1
SPINDLE: HIGH TORQUE

*X
Z

0
0
[EXIT]

>1
2
3
4
5
6
7
8
9
10
11
12
13

Y

0
5000 RPM
[ENTER]

SPEED SETTING
SPINDLE RPM
[EXIT]
MECHA MOVING
ORIGIN CHANGE
MOVING MODE
COMMAND SET
CONNECTION
SERIAL PARAMETER
COMPENSATE
OTHERS
SELF MODE
ROTARY CONTROL
To Coordinate
-<RML/MODELING>-

SPEED
SETTING

1>1
2
3
4
5

X/Y CUT SPEED
Z DOWN SPEED
X/Y MOVE SPEED
Z UP SPEED
To Main MENU
-<END>-

X/Y CUT
SPEED

Z DOWN
SPEED

1-1 X/Y CUT SPEED
< 2 mm/s>
0.5/1 to 85 mm/s
(In steps of 1 mm/s)

1-2 Z DOWN SPEED
< 2 mm/s>
0.5/1 to 85 mm/s
(In steps of 1 mm/s)

X/Y MOVE
SPEED
1-3 X/Y MOVE SPEED
< 85 mm/s>
Z UP
SPEED

Main Menu

0.5/1 to 85 mm/s
(In steps of 1 mm/s)

1-4 Z UP SPEED
< 85 mm/s>
0.5/1 to 85 mm/s
(In steps of 1 mm/s)

SPINDLE
RPM

MECHA
MOVING

[EXIT]

2 SPINDLE RPM
< 5000 RPM>
[HIGH TORQUE] mode selected: 3000 to 12000 RPM
[HIGH SPEED] mode selected : 5000 to 20000 RPM

3 >1
2
3
4
5
6
7
8
9
10

Go
Go
Go
Go
Go
Go
Go
Go
Go
To

(In steps of 100 RPM)

ORIGIN Pos.
Z0 Pos.
VIEW Pos.
Z1 Pos.
Z2 Pos.
MAX Pos.
USER Origin
CENTER Pos.
LIMIT Pos.
Main MENU
-<END>-

Next Page
95

Part 4 User's Reference

Previous Page

ORIGIN
CHANGE

4 ORIGIN

CHANGE
<USER>

USER/LIMIT/CENTER

MOVING
MODE

5>1
2
3
4
5

SPINDLE CONTROL
OVER AREA
SMOOTHING
ACCELERATION
To Main MENU
-<END>-

SPINDLE CONTROL
5-1 SPINDLE CONTROL
<ON>
ON/OFF/EXTERNAL ONLY

OVER
AREA

5-2 OVER AREA
<CONTINUE>
CONTINUE/PAUSE

SMOOTHING
5-3 SMOOTHING
<ON>
ON/OFF

ACCELERATION
5-4 ACCELERATION
<0.3G>
0.05G/0.1G/0.3G

COMMAND
SET
6 COMMAND SET

[EXIT]

<AUTO>
MODE-1/MODE-2/AUTO

CONNECTION
7 CONNECTION
<AUTO>
AUTO/SERIAL/PARALLEL

SERIAL PARAMETER
8>1 STOP BIT
2 DATA BIT
3 PARITY BIT
4 BAUD RATE
5 HAND SHAKE
6 To Main MENU
-<END>-

STOP
BIT

8-1 STOP BIT
<1>
1/2

DATA
BIT

8-2 DATA BIT
<8>
7/8

PARITY
BIT

8-3 PARITY BIT
<NONE>
NONE/ODD/EVEN

BAUD
RATE

8-4 BAUD RATE
<9600>
4800/9600/19200/38400

HAND
SHAKE

Next Page

8-5 HAND SHAKE
<HARD-WIRE>
HARD-WIRE/XON/XOFF

[EXIT]

96

Part 4 User's Reference

Previous Page

COMPENSATE
9>1
2
3
4

X-COMPENSATE
Y-COMPENSATE
Z-COMPENSATE
To Main MENU
-<END>-

X-COMPENSATE
9-1 X-COMPENSATE
<100.00 %>
99.90 to 100.10%
(In steps of 0.01%)

Y-COMPENSATE
9-2 Y-COMPENSATE
<100.00 %>
99.90 to 100.10%
(In steps of 0.01%)

Z-COMPENSATE
9-3 Z-COMPENSATE
<100.00 %>
99.90 to 100.10%
(In steps of 0.01%)

[EXIT]

OTHERS
10>1
2
3
4
5
6

SENSOR MODE
SPINDLE UNIT
BUZZER
SENSOR HEIGHT
REVOLUTION TIME
To Main MENU
-<END>-

SENSOR
MODE
10-1 SENSOR MODE
Please Cursor Move
SPINDLE
UNIT
10-2 SPINDLE UNIT
<HIGH TORQUE>
HIGH TORQUE/HIGH SPEED

BUZZER
10-3 BUZZER
<ON>
ON/OFF

SENSOR
HEIGHT 10-4 SENSOR HEIGHT
<15000 um>
0 to 30000 um
(In steps of 10 um)
REVOLUTION
TIME
10-5 REVOLUTION TIME
0 Hour

[EXIT]

SELF
MODE

11>1 SURFACE CUT
2 To Main Menu

ROTARY CONTORL
12 ROTARY CONTROL

To Coordinate
*X
0
Z
1500

SURFACE
CUT
11-1 SURFACE CUT
Are You Sure?[ENTER]

[EXIT]

Y

0
5000 RPM
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Press the [PAUSE] key

PAUSE>CONTINUE
STOP
X/Y CUT SPEED
Z DOWN SPEED
X/Y MOVE SPEED
Z UP SPEED
SPINDLE RPM
-<END>-

CONTINUE
Cutting continues

STOP
Stopping the cutting process
X/Y CUT
SPEED PAUSE:X/Y CUT SPEED
< 2 mm/s>
0.5/1 to 85 mm/s
(In steps to 1 mm/s)
Z DOWN
SPEED PAUSE:Z DOWN SPEED
< 2 mm/s>
0.5/1 to 85 mm/s
(In steps to 1 mm/s)
X/Y MOVE
SPEED PAUSE:X/Y MOVE SPEED
< 85 mm/s>

Z UP
SPEED

0.5/1 to 85 mm/s
(In steps to 1 mm/s)

PAUSE:Z UP SPEED
< 85 mm/s>
0.5/1 to 85 mm/s
(In steps to 1 mm/s)

SPINDLE
RPM
PAUSE:SPINDLE RPM
< 5000 RPM>

[HIGH TORQUE] mode selected: 3000 to 12000 RPM
[HIGH SPEED] mode selected : 5000 to 20000 RPM
(In steps of 100 RPM)

[EXIT]
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MDX-500
Switch on the power while
holding down the [EXIT] key

POWER ON
MDX-500
Roland DG Corp.

Hit "ENTER" >RML-1
Select MODE NC-CODE

1 ENGLISH
>2 JAPANESE

Select "ENGLISH"

-<END>-

[ENTER]

Select "RML-1"

[ENTER]

MODE
: RML-1
SPINDLE: HIGH TORQUE

*X
Z

0
0
[EXIT]

>1
2
3
4
5
6
7
8
9
10
11
12

Y

0
5000 RPM
[ENTER]

SPEED SETTING
SPINDLE RPM
[EXIT]
MECHA MOVING
ORIGIN CHANGE
MOVING MODE
COMMAND SET
CONNECTION
SERIAL PARAMETER
COMPENSATE
OTHERS
SELF MODE
To Coordinate
-<RML/MODELING>-

SPEED
SETTING

1>1
2
3
4
5

X/Y CUT SPEED
Z DOWN SPEED
X/Y MOVE SPEED
Z UP SPEED
To Main MENU
-<END>-

X/Y CUT
SPEED

Z DOWN
SPEED

1-1 X/Y CUT SPEED
< 2 mm/s>
0.5/1 to 85 mm/s
(In steps of 1 mm/s)

1-2 Z DOWN SPEED
< 2 mm/s>
0.5/1 to 85 mm/s
(In steps of 1 mm/s)

X/Y MOVE
SPEED
1-3 X/Y MOVE SPEED
< 85 mm/s>

Main Menu

Z UP
SPEED

0.5/1 to 85 mm/s
(In steps of 1 mm/s)

1-4 Z UP SPEED
< 85 mm/s>
0.5/1 to 85 mm/s
(In steps of 1 mm/s)

SPINDLE
RPM

MECHA
MOVING

[EXIT]

2 SPINDLE RPM
< 5000 RPM>
[HIGH TORQUE] mode selected: 3000 to 12000 RPM
[HIGH SPEED] mode selected : 5000 to 20000 RPM

3 >1
2
3
4
5
6
7
8
9
10

Go
Go
Go
Go
Go
Go
Go
Go
Go
To

(In steps of 100 RPM)

ORIGIN Pos.
Z0 Pos.
VIEW Pos.
Z1 Pos.
Z2 Pos.
MAX Pos.
USER Origin
CENTER Pos.
LIMIT Pos.
Main MENU
-<END>-

Next Page
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Previous Page

ORIGIN
CHANGE

4 ORIGIN

CHANGE
<USER>

USER/LIMIT/CENTER

MOVING
MODE

5>1
2
3
4
5

SPINDLE CONTROL
OVER AREA
SMOOTHING
ACCELERATION
To Main MENU
-<END>-

SPINDLE CONTROL
5-1 SPINDLE CONTROL
<ON>
ON/OFF/EXTERNAL ONLY

OVER
AREA

5-2 OVER AREA
<CONTINUE>
CONTINUE/PAUSE

SMOOTHING
5-3 SMOOTHING
<ON>
ON/OFF

ACCELERATION
5-4 ACCELERATION
<0.3G>
0.05G/0.1G/0.3G

COMMAND
SET
6 COMMAND SET

[EXIT]

<AUTO>
MODE-1/MODE-2/AUTO

CONNECTION
7 CONNECTION
<AUTO>
AUTO/SERIAL/PARALLEL

SERIAL PARAMETER
8>1 STOP BIT
2 DATA BIT
3 PARITY BIT
4 BAUD RATE
5 HAND SHAKE
6 To Main MENU
-<END>-

STOP
BIT

8-1 STOP BIT
<1>
1/2

DATA
BIT

8-2 DATA BIT
<8>
7/8

PARITY
BIT

8-3 PARITY BIT
<NONE>
NONE/ODD/EVEN

BAUD
RATE

8-4 BAUD RATE
<9600>
4800/9600/19200/38400

HAND
SHAKE

Next Page

8-5 HAND SHAKE
<HARD-WIRE>
HARD-WIRE/XON/XOFF

[EXIT]
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COMPENSATE
9>1
2
3
4

X-COMPENSATE
Y-COMPENSATE
Z-COMPENSATE
To Main MENU
-<END>-

X-COMPENSATE
9-1 X-COMPENSATE
<100.00 %>
99.90 to 100.10%
(In steps of 0.01%)

Y-COMPENSATE
9-2 Y-COMPENSATE
<100.00 %>
99.90 to 100.10%
(In steps of 0.01%)

Z-COMPENSATE
9-3 Z-COMPENSATE
<100.00 %>
99.90 to 100.10%
(In steps of 0.01%)

[EXIT]

OTHERS
10>1
2
3
4
5
6

SENSOR MODE
SPINDLE UNIT
BUZZER
SENSOR HEIGHT
REVOLUTION TIME
To Main MENU
-<END>-

SENSOR
MODE
10-1 SENSOR MODE
Please Cursor Move
SPINDLE
UNIT
10-2 SPINDLE UNIT
<HIGH TORQUE>
HIGH TORQUE/HIGH SPEED

BUZZER
10-3 BUZZER
<ON>
ON/OFF

SENSOR
HEIGHT 10-4 SENSOR HEIGHT
<15000 um>
0 to 30000 um
(In steps of 10 um)
REVOLUTION
TIME
10-5 REVOLUTION TIME
0 Hour

[EXIT]

SELF
MODE

11>1 SURFACE CUT
2 To Main Menu

SURFACE
CUT
11-1 SURFACE CUT
Are You Sure?[ENTER]

[EXIT]

To Coordinate
*X
0
Z
1500

Y

0
5000 RPM
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Press the [PAUSE] key

PAUSE>CONTINUE
STOP
X/Y CUT SPEED
Z DOWN SPEED
X/Y MOVE SPEED
Z UP SPEED
SPINDLE RPM
-<END>-

CONTINUE
Cutting continues

STOP
Stopping the cutting process
X/Y CUT
SPEED PAUSE:X/Y CUT SPEED
< 2 mm/s>
0.5/1 to 85 mm/s
(In steps to 1 mm/s)
Z DOWN
SPEED PAUSE:Z DOWN SPEED
< 2 mm/s>
0.5/1 to 85 mm/s
(In steps to 1 mm/s)
X/Y MOVE
SPEED PAUSE:X/Y MOVE SPEED
< 85 mm/s>

Z UP
SPEED

0.5/1 to 85 mm/s
(In steps to 1 mm/s)

PAUSE:Z UP SPEED
< 85 mm/s>
0.5/1 to 85 mm/s
(In steps to 1 mm/s)

SPINDLE
RPM
PAUSE:SPINDLE RPM
< 5000 RPM>

[HIGH TORQUE] mode selected: 3000 to 12000 RPM
[HIGH SPEED] mode selected : 5000 to 20000 RPM
(In steps of 100 RPM)

[EXIT]
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